Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

Manufactured under license from Dolby Laboratories. Dolby, Pro Logic, MLP Lossless, The "AAC" logo, and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-2004 Dolby Laboratories. All rights reserved.

Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 5,974,380; 5,978,762; 6,226,616; 6,487,535; 7,003,467; 7,212,872 & other U.S. and worldwide patents issued & pending. DTS, DTS Digital Surround, ES, and Neo:6 are registered trademarks and the DTS logos, Symbol and DTS 96/24 are trademarks of DTS, Inc. © 1996-2007 DTS, Inc. All Rights Reserved.

Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 5,974,380; 5,978,762; 6,226,616; 6,487,535 & other U.S. and worldwide patents issued & pending. DTS is a registered trademark and the DTS logos, Symbol, DTS-HD and DTS-HD Master Audio are trademarks of DTS, Inc. © 1996-2007 DTS, Inc. All Rights Reserved.
International Headquarters

Mailing Address  
CyberLink Corporation  
15F, #100, Minchiuan Road, Shindian City  
Taipei 231, Taiwan

Web Site  
www.cyberlink.com

Telephone  
886-2-8667-1298

Fax  
886-2-8667-1300

Copyright © 2009 CyberLink Corporation. All rights reserved.
Preview Window ...................................................................................................15
Zoom In/Out ......................................................................................................15
Display/Preview Options ..............................................................................16
Media Viewer ....................................................................................................17
Editing Workspace ...........................................................................................17
Timeline View ..............................................................................................20
Storyboard View ............................................................................................20

Pre-Production ................................................................. 21
Importing Media ..............................................................................................21
Downloading Media ..........................................................................................22
  Downloading Photos From Flickr ...............................................................22
  Downloading Audio From Freesound .......................................................23
  Downloading Templates from DirectorZone ............................................23
Capturing Media .............................................................................................24
  Capturing from a DV Camcorder .................................................................25
  Capturing from an HDV Camcorder ............................................................26
  Capturing from a TV Signal .........................................................................26
  Capturing from a Digital TV Signal ............................................................26
  Capturing from a Webcam ..........................................................................27
  Capturing from a Microphone ....................................................................27
  Capturing from a CD ....................................................................................27
  Capturing from a DVD ................................................................................27
  Capturing from an AVCHD Camcorder .......................................................27
Captured Content ...........................................................................................28
  Quality Profile Setup ................................................................................28
  Capture Settings .........................................................................................28
  Capture Preferences ....................................................................................28
Detecting Scenes and Extracting Audio ..........................................................29
  Detecting Scenes in a Video Clip .................................................................29
  Extracting Audio from a Video Clip ...........................................................30
PowerDirector Preferences .............................................................................30
  File Preferences .........................................................................................31
  General Preferences ...................................................................................32
Creating Your Story ...................... 37

Creating Your Story

PowerDirector Projects ................................................................. 37
Setting Project Aspect Ratio ......................................................... 37

Adding Media to the Editing Workspace ............................... 37
    Magic Movie Wizard ................................................................. 38
    Slideshow Designer ................................................................. 38
Adding Video, Photos and Audio to the Workspace ............................ 42
Adding Video Effects, PiP Objects, Particle Effects, Titles and Transitions ............................ 44

Editing Your Media ........................................................................ 47
    Splitting a Clip ........................................................................ 47
    Trimming Video and Audio Clips ........................................ 47
    Setting Clip Duration ................................................................. 49
    Muting Media Clips ................................................................... 50

Editing Images ............................................................................. 51
Fixing and Enhancing Photos/Videos .............................................. 51
Power Tools .................................................................................. 51
Freeze Frame Effect ....................................................................... 52
Time Info ...................................................................................... 52
Setting Video Clip Interlacing Format .............................................. 52
Adjusting Video Clip Aspect Ratio ................................................. 53

Using Magic Tools ....................................................................... 53
    Magic Movie Wizard ................................................................. 54
    Magic Fix .................................................................................. 54
    Magic Motion ........................................................................... 54
    Magic Cut ................................................................................ 56
    Magic Style ............................................................................. 56
    Magic Music ............................................................................. 57

Modifying Effects ....................................................................... 57
Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing process. It also provides an overview of the program, outlines all of the new features, and includes the system requirements for this version of CyberLink PowerDirector.

Note: this document is for reference and informational use only. Its content and the corresponding program are subject to change without notice.

Welcome

Welcome to the CyberLink family of digital video tools. CyberLink PowerDirector is a digital video editing program that lets you create professional-looking videos and photo slideshows, complete with music, voice-overs, special effects,
transitions and much more. You can then output your video to a file, upload it directly to YouTube or Facebook, or burn it to a disc, complete with stylish menus.

**Latest Features**

This section outlines the latest features within the CyberLink PowerDirector program.

**Workspace**

- **Explorer view**
  - Use the explorer view to better manage your media library.
- **Previewing video**
  - Preview your video at full screen or on a secondary display device, such as a monitor or a DV camcorder.
- **Range selection**
  - Use the range selector to select segments of media on the timeline to copy or remove it from your creation.
- **Grid lines and boundary**
  - Use grid lines and the boundary, which you can snap to as a reference point, to assist in the precise placement of PiP media and titles.
- **Expandable Workspace**
  - Expand the CyberLink PowerDirector workspace to fit your needs and personal preference.
- **Zoom in/out on preview window**
  - Useful tool that lets you zoom in or out on the preview window when using PiP media in your video.

**Edit**

- **Enhanced Slideshow Designer**
  - Customize cell, 3D, highlight and motion slideshows using the Slideshow Designer.
- **Power Tools**
  - Use Power Tools on your video to crop, rotate, play it in reverse or change the speed.
- **Fix and enhance your media**
  - Stabilize, adjust the lighting in, or enhance/upscale your videos with TrueTheater technology.
  - Apply video or audio denoise to your video files.
Chapter 1: Introduction

- Adjust the brightness, remove red-eye or apply focus to photos.
- Particle Designer
  - Use the Particle Designer to create cool PiP effects, such as falling snow.
- Track Manager
  - Add additional PiP tracks to the timeline, allowing you to have up to nine PiP tracks on a video at the same time.
  - Add additional music tracks to the timeline, allowing you to have up to three separate music tracks in a video at the same time.
- Previewing content
  - Preview your video production at full screen in the Media Viewer.
  - Preview your video production on a separate display device or camcorder when you enable dual displays.

Produce

- Produce window
  - All new, easy to use Produce window, that makes outputting your video a breeze.
- Mobile phone format
  - Output videos into H.264 format for WOOO video.
- Upload to Facebook
  - Uploaded your video productions directly to your Facebook page.
- Share timeline info
  - Share your project’s timeline info on DirectorZone to show others how you created your video production.

Create Disc

- Create Disc window
  - All new, redesigned user interface.
  - Add multiple video titles to a created disc.
  - Ability to preview the entire disc structure.
- Enhanced menu creation:
  - Multi-layered menus and a more easy-to-use and powerful menu designer.
- Burn to removable disk
  - Burn your video projects to a removable disk in the AVCHD format.

Green features and space saving

- Auto shutdown
- CyberLink PowerDirector can automatically shut down your computer after producing your video or burning it to disc, to save energy.

- Manually delete temp files
  - Ability to manually delete temp files to quickly free up disk space on your computer.

Miscellaneous

- Full UI integration of DirectorZone
  - Browse, view and search for PiP objects, title templates, particle objects and disc menus on DirectorZone, from within the CyberLink PowerDirector user interface.

- CPU/GPU optimization
  - CyberLink PowerDirector is optimized with the latest technology to provide performance gains during the rendering of HD video content when producing videos or burning them to discs.

DirectorZone

DirectorZone is a web service that lets you search for and download PiP objects, title templates, particle objects and disc menus created by other users of CyberLink PowerDirector. You may also share your own creations by uploading them to DirectorZone.

To sign in to DirectorZone, click the Sign in to DirectorZone link on the top of the CyberLink PowerDirector window. Go to http://directorzone.cyberlink.com to view more information on the features and benefits of the DirectorZone web site.

PowerDirector Versions

The features that are available to you within CyberLink PowerDirector are completely dependent on the version you have installed on your computer. File format support, editing features, disc-making functions, and other features vary depending on the version that you have.

Check the readme file for detailed versioning information. To determine the version and build number of your installed program, click on the CyberLink PowerDirector logo in the top right corner.
Chapter 1: Introduction

Upgrade Your Software
Software upgrades are available from CyberLink. To upgrade your software, click the Upgrade button on the About CyberLink PowerDirector window. The Upgrade window will open and you can select to download new upgrades and updates for CyberLink PowerDirector. You will be redirected to CyberLink’s cyberstore if you choose to purchase new upgrades.

Note: you must connect to the Internet to use this feature.

PowerDirector Modes
CyberLink PowerDirector has separate modes that enable you to perform different tasks: Capture, Edit, Produce and Create Disc.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Captures media in a variety of formats, from a variety of sources. See &quot;Capturing Media&quot; on page 24.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit your production by adding video and photos to the timeline, then add transitions, effects, titles and much more. See &quot;Creating Your Story&quot; on page 37.</td>
</tr>
<tr>
<td>Produce</td>
<td>Output your created video to a file, camcorder (DV, HDV or HDD), or upload it to YouTube or Facebook. See &quot;Producing Your Video&quot; on page 79.</td>
</tr>
<tr>
<td>Create Disc</td>
<td>Create and burn your video to a disc, complete with a professional looking disc menu. See &quot;Creating Discs&quot; on page 87.</td>
</tr>
</tbody>
</table>

By default, CyberLink PowerDirector opens in the Edit mode, but you can easily switch between modes to perform your required task by using these buttons.
## System Requirements

The system requirements listed below are recommended as minimums for general digital video production work.

**System Requirements**

<table>
<thead>
<tr>
<th>Screen Resolution</th>
<th>• 1024 x 768, 16-bit color or higher</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>• Windows 7/Vista/XP (Windows XP Service Pack 2 is required for HDV capture).</td>
</tr>
<tr>
<td>Memory</td>
<td>• 512 MB required</td>
</tr>
<tr>
<td></td>
<td>• 2GB DDR2 or above recommended for editing HD videos</td>
</tr>
<tr>
<td>CPU</td>
<td>• AVI Capture/Producer: Pentium II 450 MHz or AMD Athlon 500 MHz</td>
</tr>
<tr>
<td></td>
<td>• VCD Quality (MPEG-1) Profiles: Pentium III 600 MHz or AMD Athlon 700 MHz</td>
</tr>
<tr>
<td></td>
<td>• DVD Quality (MPEG-2) Profiles: Pentium 4 2.2 GHz or AMD Athlon XP 2200+</td>
</tr>
<tr>
<td></td>
<td>• High Quality MPEG-4 and Streaming WMV, QuickTime, RealVideo) Profiles: Pentium 4 2.4 Ghz or AMD Athlon XP 2400+</td>
</tr>
<tr>
<td></td>
<td>• AVCHD and MPEG-2 HD (for BD/HD burning) Profiles: Pentium Core 2 Duo E6400 or Athlon 64 X2 5000+</td>
</tr>
<tr>
<td>Video Capturing Device</td>
<td>• PCI or USB1.0/2.0 capture device compliant with WDM standard (i.e. PC Camera and TV tuner with WDM driver)</td>
</tr>
<tr>
<td></td>
<td>• DV camcorder connected via OHCI-compliant IEEE1394 (check CyberLink web site) for supported model list</td>
</tr>
<tr>
<td></td>
<td>• DVD camcorder connected via USB2.0 (check CyberLink web site) for supported model list</td>
</tr>
<tr>
<td></td>
<td>• Sony MicroMV/AVCHD/HDV camcorder (check CyberLink web site) for supported model list</td>
</tr>
<tr>
<td></td>
<td>• JVC Everio camcorder (check CyberLink web site) for supported model list</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

System Requirements

| Hard Disk Space | • 5 GB required (400MB for SmartSound Quicktrack Library)  
|                 | • 10 GB (20 GB recommended) required for DVD production  
|                 | • 60GB (100GB recommended) required for BD/HD/AVCHD production |

| Burning Devices | • A CD or DVD burner (CD-R/RW, DVD+R/RW or DVD-R/RW) is required to burn VCD/DVD/SVCD/AVCHD* titles  
|                 | • A Blu-ray Disc recordable drive is required to burn Blu-ray Disc titles* |

| Microphone | • A microphone is required for recording voice-overs |

**Note:** please consult the CyberLink web site for the most recent system requirements information. [http://www.cyberlink.com](http://www.cyberlink.com). * optional features in CyberLink PowerDirector. Check the readme file for detailed versioning information.
Chapter 2:

The PowerDirector Workspace

This chapter outlines the CyberLink PowerDirector workspace, and all of its features. The workspace is where you will spend most of your time within CyberLink PowerDirector, so getting familiar with everything it has to offer will be helpful.

A - Rooms, B - Library Window, C - Explorer View, D - Expandable Workspace, E - Fit/Scroll in Timeline, F - Resizing the Ruler, G - Preview Window, H - Display/Preview Options, I - Zoom In/Out, J - Media Viewer, K - Take Snapshot/Preview Quality, L - Editing Workspace, M - Range Selection, N - Track Manager, O - Timeline/Storyboard View
Rooms
The various rooms within the Edit module of CyberLink PowerDirector are where you can access all of your media, effects, titles, and transitions when editing your video. You can also gain access to controls for recording and mixing audio, adding chapters or subtitles. By default, the library window displays the Media Room.

Media Room

The Media Room provides access to your media library. The media library can contain your video and audio files, as well as many types of images. You can also gain access to a number of useful color boards in the Media Room when within the explorer view.

Managing the Library

Use the button to manage the media within your library. The options include:

- exporting your entire media library as a PDL file.
- importing a media library PDL file, exported from another project or version of CyberLink PowerDirector.
- emptying the entire contents of the media library.

Effect Room

The Effect Room contains a library of special effects that are used on the video files and images in your project. For more information, see "Adding Video Effects" on page 44.

PiP Objects Room

The PiP Objects Room contains a library of graphics that are added on top of the video or images on the master track. There are three main types of objects:

- static graphics.
- motion graphics that fly through clips.
- decorative borders that are added to frame your clip.

Inserted objects are displayed on the PiP Track and modified in the PiP Designer. For more information, see "Adding PiP Objects" on page 45.
Particle Room

The Particle Room contains a library of effects that are placed on the PiP track to add a particle effect (snow, dust, smoke, etc.) on top of a video or image on the master track.

Title Room

The Title Room contains the library of titles that when applied to your project, add credits or comments to your production. For more information, see "Adding Title Effects" on page 46.

Transition Room

The Transition Room is a library of transitions that are used between video clips or images in your project, helping to make edits appear smoother and more professional. For more information, see "Adding Transitions" on page 46.

Audio Mixing Room

In the Audio Mixing Room you can use controls to mix all of the audio tracks in your project. For more information, see "Mix Audio Levels in the Audio Mixing Room" on page 72.

Voice-Over Recording Room

In the Voice-Over Recording Room you can record a voice over for your video, while you are watching it play back. For more information, see "Record a Voice-Over" on page 74.

Chapter Room

In the Chapter Room you can automatically or manually set chapter markers for your project. Setting chapters on your final disc allows viewers to jump from the menu page to the chapter markers you have set in order to navigate around your disc. For more information, see "Chapters" on page 75.
Subtitle Room

Within in the Subtitle Room you can add subtitles to your video production manually or through the import of a TXT or an SRT file. For more information, see "Subtitles" on page 76.

Library Window

The library window contains all of the media in CyberLink PowerDirector, including your video, images and music files. It can also contain the effects, titles and transitions you apply to your media.

The media content that is displayed in the library window depends on the room you are currently within.

Explorer View

Select the button to toggle the explorer view within the library windows. Within the explorer view you can gain access to your library folders in order to organize your media into subfolders. In the explorer view you can:

- click on to add a new subfolder in a library window.
- select an existing folder and click to delete a previously created subfolder.
- browse a folder’s contents in the library window by selecting it.
Note: you can also gain quick access to library folders by selecting them from the available drop down menu or clicking on the UI.

Library Menu

Click on to gain access to the library menu. In the library menu you can sort or change the display of the content in the library window, depending on your preference. Other options are available in the library menu and depend on the specific room you are within.

Expandable Workspace

The look of the CyberLink PowerDirector workspace is fully expandable and customizable based on your personal preference.

Simply drag the borders of the preview window and timeline to resize them to your liking. This allows you to get the most out of your display device space and customize the size of the preview window as you work.

Fit/Scroll in Timeline

After you have resized your workspace to your liking or added additional PiP or music tracks to the timeline using the Track Manager, click on the button so
that all tracks are displayed within the existing timeline. This ensures that you don’t need to scroll to view certain tracks.

Click the button for a larger display of the tracks in the timeline, and enable scrolling up and down in the timeline.

**Note:** when scrolling is enabled within the timeline, the Master Video Track will always remain on top of the other tracks when scrolling through the tracks.

**Resizing the Ruler**

You can resize the timeline ruler for a more expanded or condensed view of your production. To resize the ruler, click on the ruler and drag it. Expanding the ruler is especially handy when aligning clips and effects, while condensing it gives you a global overview of your entire production. You can also use the timeline slider to resize the timeline.
Preview Window
While creating your video production, preview your production in the preview window using the available playback controls.

Click the **Clip** button to play back the clip that is selected in the timeline, or **Movie** to play the entire video production. You can also control the quality of the previewed video (as well as take a photo snapshot of the current frame of video) by selecting [ ] and then the preview resolution from the list.
CyberLink PowerDirector also offers several other preview methods for viewing your production, including viewing your production at full screen in the Media Viewer or on a secondary display device.

**Zoom In/Out**

When you place media on the PiP track of the timeline, use the **Fit** drop-down to zoom in or out on the preview window. Zooming in is useful for precise placement of PiP media, while you can zoom out if you want to add PiP media that begins off screen.
Display/Preview Options

CyberLink PowerDirector includes some display and preview options that help make your editing experience easier. Click on  to enable the TV safe zone, display grid lines, use a dual preview, and select a preview mode.

TV Safe Zone/Grid Lines

When you place media on the PiP track of the timeline, use the TV safe zone and grid lines to help with the precise placement on your video’s image.

- Click the  button and then select TV Safe Zone to enable a box that indicates the on-screen area of most TV displays.
- Click the  button, select Grid Lines and then select the number of lines you want to display in a grid over the video image. Use this grid to more precisely place the PiP media where you want on the video image.

Once enabled, select Snap to Reference to have the selected objects snap to the grid lines, TV safe zone and the boundary of the preview window.

Dual Preview

If you have a secondary display device, such as a monitor, TV, or DV camcorder connected to your computer, click the  button and select Dual Preview to extend your workspace and preview your project on a secondary display.

Note: to use a connected monitor or TV as a secondary preview window, you must first enable extend desktop to a secondary display within the Windows Display Properties Settings.

Once enabled, when you select play on the preview window, you can preview your production on both your primary and secondary display (TV or monitor), or on a connected DV camcorder, depending on your selected preference.

Preview Mode

CyberLink PowerDirector provides two modes you can use to preview your video production:

- Real-time: synchronizes and renders clips and effects in real-time, displaying a preview of your video at the standard 25 (PAL)/30 (NTSC) frames per second.
• **Non Real-time**: mutes the audio and displays a preview at a reduced speed to help make editing much more fluid. Useful when editing high-definition video, using multiple PiP tracks on a less powerful computer, or when you receive dropped frames when previewing. By muting the audio and slowing down the video, CyberLink PowerDirector lets you view more frames per second when your computer has trouble providing a smooth preview during editing.

**Media Viewer**

The Media Viewer is similar to the preview window, but provides a larger display of your production, including an option to view it at full screen.

To use the Media Viewer:

• click 🎬 in the preview window to launch the Media Viewer.
• click 🎬 in the Media Viewer to view your production at full screen.
• click 🎬 in full screen mode to return the window to the normal size.
• click 🎬 in full screen mode to close the Media Viewer.

**Editing Workspace**

The editing workspace is where you create your project by adding your media, various effects, transitions, and titles. The editing workspace has two different views, the Timeline and Storyboard view, which are accessed by clicking on the 🎬 or 📋 buttons.

**Note**: you can set which workspace view is displayed by default in "Editing Preferences" on page 33.

**Timeline View**

The timeline view lets you view your entire project based on running time. This view is useful if you want to insert effects, subtitles, etc. at a specific moment in production. The timeline view also provides a view of all the tracks, media and other content (chapter markers, subtitle markers) that are displayed in the timeline. To switch to timeline view, click 🎬.
# Media Tracks

The timeline contains the following tracks:

<table>
<thead>
<tr>
<th>Track</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Master Video Track" /></td>
<td><strong>Master Video Track</strong> contains your project’s main video and/or image clips.</td>
</tr>
<tr>
<td><img src="image" alt="Effect Track" /></td>
<td><strong>Effect Track</strong> contains special effects that apply to the video or image clip in the Master Video Track at the same location.</td>
</tr>
<tr>
<td><img src="image" alt="PiP Track" /></td>
<td><strong>PiP Track</strong> contains video clips, images, objects and particle effects that are inserted over any clip in the Master Video Track that appear during the PiP effect’s duration. Within the <strong>Track Manager</strong> you can add up to eight additional PiP tracks into the timeline. The PiP tracks are numbered within the timeline accordingly.</td>
</tr>
<tr>
<td><img src="image" alt="Title Track" /></td>
<td><strong>Title Track</strong> contains title effects that appear over any clips in the Master Video Track that occur during the title effect’s duration.</td>
</tr>
<tr>
<td><img src="image" alt="Voice Track" /></td>
<td><strong>Voice Track</strong> contains a narrative voice-over or second audio clip.</td>
</tr>
<tr>
<td><img src="image" alt="Music Track" /></td>
<td><strong>Music Track</strong> contains your project’s main audio and music clips. Within the <strong>Track Manager</strong> you can add up to two additional music tracks into the timeline. The music tracks are numbered within the timeline accordingly.</td>
</tr>
<tr>
<td><img src="image" alt="Chapter Track" /></td>
<td><strong>Chapter Track</strong> contains all of the chapters markers in your current video production. This track only displays when you are within the Chapter Room.</td>
</tr>
<tr>
<td><img src="image" alt="Subtitle Track" /></td>
<td><strong>Subtitle Track</strong> contains all of the subtitle markers in your current video production. This track only displays when you are within the Subtitle Room.</td>
</tr>
<tr>
<td><img src="image" alt="SVRT Track" /></td>
<td><strong>SVRT Track</strong> displays the SVRT information for your current project. See &quot;Viewing SVRT Information&quot; on page 79 for more information.</td>
</tr>
</tbody>
</table>
**Range Selection**

Click and drag one of the arrows on either side of the timeline slider to select a range of media on the timeline.

Once selected, you can cut or copy and then paste the selected media to another position on the timeline.

You can also use this feature to manually highlight a portion of a clip that you want to then remove or trim out.

**Track Manager**

Within the Track Manager* you can add additional PiP or music tracks to the timeline. This allows you to have up to nine PiP objects displayed on a video at the same time, or up to three pieces of music in your production. To add tracks to the timeline, click on and then select the number of PiP or music tracks you would like to add.

---

**Note:** * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

**Locking/Unlocking Tracks**

To lock a track in the timeline, click at the left of the track. When a track is locked, you cannot add new clips to the track, nor move or edit the clips it contains. To unlock a track in the timeline, click at the extreme left of the track.
**Showing/Hiding Tracks**

To hide a track in the timeline*, first click **Movie** in the Preview window, then click at the extreme left of the track. When a track is hidden, it is not displayed in the Preview window. This way you can preview your project by tracks and concentrate on the track you are working on.

* optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

To display a track that is hidden in the timeline, first click **Movie** in the Preview window, then click to the left of the track.

**Storyboard View**

The storyboard view is essentially a large graphical display of your project, which can help you visualize the scenes and the overall production more clearly. To switch to storyboard view, click .

* a number of features are unavailable in the storyboard view. If you try and perform a function that is not available in this view, CyberLink PowerDirector automatically switches back to the timeline view.
Chapter 3: Pre-Production

This chapter details the steps required for pre-production, including the import of media into the Media Room’s library, the capture of media within CyberLink PowerDirector and setting your CyberLink PowerDirector preferences.

Importing Media

If you already have video files, music and images that you want to use in your production (for example on your computer’s hard drive, a removable device, etc.), you can import the files directly into CyberLink PowerDirector’s library in the Media Room.

CyberLink PowerDirector supports the following file formats:

**Image:** JPEG, TIFF, BMP, GIF, PNG

**Video:** DV-AVI, Windows-AVI, DAT, MPEG-1, MPEG-2, DVR-MS, VOB, VRO, WMV, MOV, MOD, TOD, MPEG-4, MTS, M2TS, JTS, TS, M2T, 3GP, 3GPP2

Additional formats available on Windows 7: Divx, Xvid

**Audio:** MP3, WAV, WMA, M4A

---

**Note:** the supported file formats depend on the version of CyberLink PowerDirector you have installed on your computer. Check the readme file for detailed versioning information.

---

Click ![Import Media](image) to import media into the media room’s library, using one of two options:

- import media files individually.
- import an entire folder that contains media files you want to use in your current project.

---

**Note:** you can also drag and drop media onto the CyberLink PowerDirector window to import it into the program.
Downloading Media

If you feel that you do not have enough media for your project, or you are looking for specific media to make your creation just perfect, you can:

- click to download media from the Internet directly into the media library.
- click to download PiP effects, particle effects, title templates, or disc menus from DirectorZone.

Downloading Photos From Flickr

You can download your own photos directly from your account on Flickr into CyberLink PowerDirector. You can also search for and browse other users’ photos from within CyberLink PowerDirector, and then import them into your Media Library for use in a project.

To download photos from Flickr, do this:

1. Click on and then select Import from Flickr.
2. Follow the steps within the wizard window to authorize CyberLink PowerDirector to use your Flickr account and accept the Terms of Use from Flickr.

Note: having a Flickr account is not required to search for, browse and download photos from Flickr.

3. Select from the drop down whether to search for photos from:
   - My Photos on Flickr: this option displays thumbnails of all the photos you have uploaded to your Flickr account.
   - My Contacts' Photos: this option displays thumbnails of all the photos your Flick contacts have uploaded to Flickr.
   - Search for Photos on Flickr: select this option to perform a search for photos on Flickr.

Note: use the drop down filter menu at the top of the search window to sort the photos.
4. Select all of the photos that you want to import into your Media Library and then click on the **Download** button.

**Note:** you cannot use the photos downloaded into your Media Library for commercial use. Click on the button underneath a photo thumbnail to view its copyright information.

### Downloading Audio From Freesound

You can download audio samples, such as sound effects or music clips, from the Freesound service into CyberLink PowerDirector. To download audio clips from Freesound, do this:

1. Click on ![ ] and then select **Import from Freesound**.
2. Follow the steps within the wizard window to sign in to Freesound and then accept the Terms of Use.
3. Within the search window, perform a search for the audio clips you are looking for.

**Note:** use the check boxes to filter the keyword search criteria before performing your search.

4. Select all of the audio that you want to import into your Media Library and then click on the **Download** button.

**Note:** you cannot use the audio downloaded into your Media Library for commercial use. Click on the button underneath an audio thumbnail to view its copyright information.

### Downloading Templates from DirectorZone

If you are looking for additional PiP objects, title effects, particle effects or disc menu templates for your library, you can download them from the DirectorZone web site by clicking on ![ ] within the PiP Objects Room, Particle Room, Title Room or the Disc Menu window.
DirectorZone is now fully integrated into the CyberLink PowerDirector UI for convenient searching and previewing of the available templates. These templates are created by either CyberLink or other CyberLink PowerDirector users, and then uploaded to DirectorZone.

**Capturing Media**

CyberLink PowerDirector lets you capture media from a variety of sources directly into your Media Library. When you click the **Capture** button you enter the capture window. In the capture window, the program appears as follows:

A - Capture from a DV Camcorder, B - Capture from an HDV Camcorder, C - Capture from a TV Signal, D - Capture from a Digital TV Signal, E - Capture from a Webcam, F - Capture from a Microphone, G - Capture from a CD, H - Capture from a DVD or from an AVCHD Camcorder, I - Captured Content, J - Quality Profile Setup, K - Capture Settings, L - Capture Preferences
Capturing from a DV Camcorder

DV camcorders are popular among video hobbyists, as they record in a digital format that does not require conversion before being used on a computer. You can capture a single scene or a number of scenes in a batch from your camcorder.

Note: if your DV camcorder connects to your computer via USB, you must import video files directly as if your camcorder is a regular hard drive. See "Importing Media" on page 21 for information on importing video files.

Capturing a Single Scene

You can capture a single segment of video from your camcorder. This function is particularly useful, for example, if you want to acquire a long video segment in its entirety without skipping over sections.

DV Backup

The DV Backup* feature lets you back-up the digital video from your DV camcorder directly to DVD using CyberLink PowerDirector. Click the button to begin backing up your video.

Note: this feature requires a DVD burner. * Optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

Batch Capture from a DV Camcorder

Batch capturing may seem intimidating, but in reality it is an incredibly convenient method of capturing multiple video clips automatically. If you take a few minutes to familiarize yourself with batch capturing, you will save yourself time when you capture video from your camcorder. CyberLink PowerDirector scans your DV for intervals (or allows you to set them manually), then captures them in a batch using the intervals you created.
Automatic Batch Capture
Automatic batch capture is a quick way to capture scenes from a video tape. Click the button to access the automatic batch capture feature.

Manual Batch Capture
Using manual batch capture* gives you more control over the capturing process and ensures that the scenes you want to include are captured. Manual batch capture is recommended when you are sure which scenes you want to capture and have a good idea where they are located on the tape. Click the button to access the manual batch capture feature.

Note: * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

Capturing from an HDV Camcorder
HDV camcorders record in a high definition digital format that does not require conversion before being used on a computer. You can capture scenes from your HDV camcorder directly into CyberLink PowerDirector.

Note: if your HDV camcorder connects to your computer via USB, you must import video files directly as if your camcorder is a regular hard drive. See "Importing Media" on page 21 for information on importing video files.

Capturing from a TV Signal
You may wish to add segments from your favorite TV programs to your video production, or simply record other segments for different uses.

Capturing from a Digital TV Signal
You may wish to add segments from your favorite Digital TV programs to your video production, or simply record other segments for different uses.
Chapter 3: Pre-Production

Note: this feature is not available in all regions.

Capturing from a Webcam
Webcams are inexpensive, handy video cameras that you can use for simple video capturing.

Capturing from a Microphone
Your video may require recorded dialog. No matter what kind of audio tracks you record, you can capture them with a microphone for use in your CyberLink PowerDirector project.

Capturing from a CD
Using your favorite music can help you to create a really fun, personalized video. If you have music stored on an audio CD, you can record songs you want and then add them as audio tracks in your CyberLink PowerDirector project.

Capturing from a DVD
You can capture video scenes (including the audio portion) from a DVD for use in your CyberLink PowerDirector project.

Note: some DVDs are protected by technology that does not allow you to capture the content they contain.

Capturing from an AVCHD Camcorder
AVCHD camcorders record in a high definition digital format that does not require conversion before being used on a computer. You can capture scenes from your AVCHD camcorder directly into CyberLink PowerDirector.
Note: if your AVCHD camcorder connects to your computer via USB, you must import video files directly as if your camcorder is a regular hard drive. See "Importing Media" on page 21 for information on importing video files.

Captured Content

All of the media you capture in the capture window is displayed in the Captured Content area. When you return to the Edit window, all of the media in the Captured Content area is automatically imported into your Media Room’s library. Within in the Captured Content area you can right click on media to perform a number of options, including detecting scenes in video clips and deleting unwanted content so that it won’t import into Edit window. Select the Change Folder button to specify the folder you want all of the captured media to be stored.

Quality Profile Setup

When capturing media you can select its file format and quality profile by clicking the Profile button. CyberLink PowerDirector’s capture functions vary, depending on the version installed. For information on the availability of specific features in the version that you are using, please check the Readme file.

Capture Settings

Use the Settings button to configure the set up of your selected capture device. The capture settings that are available depend on the capture device connected and the capture mode you have selected.

Note: when capturing from a DVD, this button reads Drive, allowing you to select the specific disc drive you want to capture from, if required.

Capture Preferences

Before capture you can set preferences for your captured content. The capture preferences that are available, depend on the content you are capturing.
Chapter 3: Pre-Production

- to set a maximum capture length, select **Time limit** and then enter a time in the time code box.
- to set a maximum captured file size, select **Size limit** and then enter a size limit (in MB).
- to add a text remark, date or time code to captured video, click on 📌.
- to take a still photo of a frame video for use in your project, just click on 📸 at the point where you want to take the snapshot and an image is saved to the Captured content area. You can specify your preferred snapshot image file format in preferences. See "File Preferences" on page 31 for detailed information.

**Note:** when CyberLink PowerDirector captures content from a RichVideo compliant DV camcorder, timecode information is automatically captured as well. You can enable it in the Edit window using the Time Info button when the video clip is placed on the timeline. See "Time Info" on page 52 for more information.

- select **Non real-time** when capturing from a camcorder to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.
- select **Begin with fade-in** to add a fade-in to audio captured with a microphone.
- select **End with fade-out** to add a fade-out to audio captured with a microphone.
- select **Record at maximum speed** to record CD audio at a higher speed. Capturing at a higher speed reduces processing time, but yields audio of a lower quality.

### Detecting Scenes and Extracting Audio

To assist with your editing process, CyberLink PowerDirector can detect scenes in your video clips or extract the audio from them. These new clips are displayed, separately from the original clips, in the media library.

### Detecting Scenes in a Video Clip

The scene detection function automatically creates individual clips based on the individual scenes (or pre-edited shots) contained within a video clip. Detected
scenes are not split from the original clip, but are added to the workspace like any other media clip.

To detect the scenes in a video clip, right-click on it in either the Captured Content area or within the media library and select **Detect Scenes** and then on **Detect**.

**Note:** depending on the file format, scene detection on certain clips may not work as precisely as it does for others. You may need to split the scenes manually in the scene detection dialog.

The detected clips are displayed in a sub folder under the original video clip. You can add them to timeline or manage them in the media library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the lower right-hand corner of the clip when displayed in the media library. To display a clip’s scenes, click the folder icon.

**Extracting Audio from a Video Clip**

If you want to include just the audio from a video clip, you can extract it from the video clip in the media library by right-clicking it and selecting **Extract Audio**. The audio clip is separated from the video and can be used in your project like any other audio file.

**Note:** when a video clip is already on the timeline, you can separate the audio from the video file by right-clicking on it selecting **Split Audio**. For more information, see "Splitting Audio from a Video Clip" on page 71.

**PowerDirector Preferences**

Before you get started working on your production you may want to set your preferences to your liking. You may also edit them at any time during the production process to accommodate your needs.
Chapter 3: Pre-Production

File Preferences

To set your file preferences, click 📋 > Edit > Preferences. The Preferences window opens, displaying the File tab. Available options are as follows:

Default locations
- **Import folder**: indicates the last folder that media was imported from. To change this folder, click Browse and then select a new folder.
- **Export folder**: set the folder where captured media is saved. To change this folder, click Browse and then select a new folder.

File name
- **Captured video prefix**: enter a default name for captured video files. CyberLink PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file.
- **Always prompt me to confirm file name**: Check this option if you would like CyberLink PowerDirector to prompt you to enter a file name each time you capture a video clip.
- **Production file prefix**: enter a default name for your produced files.
- **Snapshot file name**: enter a default name for captured snapshots. CyberLink PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. Select a file format from the drop-down list for your snapshots. You have the choice between BMP, JPG, GIF and PNG formats.
- **Always prompt me to confirm file name**: select this option if you would like CyberLink PowerDirector to prompt you to enter a file name each time you take a snapshot.
- **Snapshot destination**: select a destination for captured snapshots from the drop-down list if you don’t want to save them as a file.
- **Use master video size whenever possible**: select this option for the snapshot to be the same size as the original video, instead of the smaller preview window it is taken in.
- **Number of recently used project(s)**: enter the number (between 0 and 20) of recently used projects that you would like to make available in the File menu when you open CyberLink PowerDirector.
- **Automatically load the last project when PowerDirector opens**: select this option to automatically load the last project you were working on.
- **Automatically load sample clips when PowerDirector opens**: select this option to have the sample media files load into the media library every time the program opens.
General Preferences

To set your general preferences, click > Edit > Preferences. The Preferences window opens, and then click the General tab. Available options are as follows:

Application
- **Maximum undo levels**: enter the number (between 0 and 100) of undos (Ctrl+Z) you would like to make available while you work on your video production. Setting a higher number consumes more CPU resources.
- **TV format**: select the TV format (NTSC or PAL) for your video. This format should correspond to the format of the region in which you plan to play your video (if you burn it to disc).
- **Enable animated Interface**: select to enable the animated interface within CyberLink PowerDirector. Enabling this consumes more CPU resources.
- **Show sound waveform in Timeline**: select to display the sound waveform in the timeline that represents the sound levels in the audio portion of video clips, music clips and voice clips.
- **Enable file processing to speed up high definition video editing**: select this to speed up the editing of high definition video by enabling CyberLink PowerDirector to process the file faster. Enabling this consumes more CPU resources.
- **Auto delete temporary files every**: select to have CyberLink PowerDirector automatically delete temporary files created while editing, every specified number of days. Click on the Manually Delete button if you want to select and delete specific temporary files.

RichVideo
- **Enable appending of information into files as RichVideo information**: select to allow CyberLink PowerDirector to append RichVideo information into the media files.
- **Enable the RichVideo information in open media dialog**: select to have CyberLink PowerDirector display RichVideo information when importing media into the Media Library.

Internet
- **Automatically check for software updates**: select to periodically check for updates or new versions automatically.

Language
- **Use system default language**: select this option for the language display to be the same as the language of your operating system.
• **User defined**: select this option and then select the language from the drop-down list that you want to use.

## Editing Preferences

To set your editing preferences, click 🍎 > **Edit > Preferences**. The Preferences window opens, and then click the **Editing** tab. Available options are as follows:

### Timeline

- **Default workspace**: select whether to display the timeline or storyboard editing workspace by default.
- **Link all tracks when moving/removing content in Video Track**: links titles, video effects, music and PiP clips to clips in the Master Video track. Selecting this option moves these clips when a video clip in the Master Video track is moved. De-select this option to allow for the movement of all timeline clips separately.
- **Add transition between photos when applying Magic Motion**: select this option to add the transition selected in **Transition type** between photos when using the Magic Motion tool and apply to all photos.
- **Add an effect and a title when using Freeze Frame**: select this option to automatically add an effect and title to the timeline when you click the Freeze Frame button.

### Durations

- set the default durations (in seconds) for image files and the different effects when placed in the timeline.
- **Auto save project**: select this to automatically save your project, every specified number of minutes, so you don’t lose your changes by accident.

### GPU acceleration

- **Enable NVIDIA CUDA/ATI Stream technology to speed up video effect preview/render**: if your computer is using a NVIDIA graphics card that supports CUDA technology or an ATI graphics card that supports Stream technology, you can select this option to speed up rendering of some video effects and MPEG-4 video by tapping into the multi-core parallel processing power of GPUs.
CyberLink PowerDirector

**Note:** to activate NVIDIA CUDA/ATI Stream encoding technology during production, select **Hardware video encoder** in the production preferences section of the produce window before production.

---

**Confirmation Preferences**

To set your confirmation preferences, click **File > Edit > Preferences**. The Preferences window opens, and then click the **Confirmation** tab. Available options are as follows:

**Confirmation**

- **Always prompt me when TV format conflicts**: select this option to enable a warning message when you add a video clip to the workspace whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the editing workspace.
- **Always prompt me when aspect ratio conflicts**: select this option to enable a warning message when you add a video clip to the workspace whose aspect conflicts with that of the project.
- **Enable file deletion from hard drive**: select this option if you would like to enable the deletion of files from your hard drive from within the media library.
- **Enable warning when chapters are removed during editing**: select this option to enable a warning message if chapter points are deleted during video editing.
- **Always prompt me when widescreen is not supported**: select this option if you would like to be prompted when a widescreen format is not supported.

---

**Capture Preferences**

To set your capture preferences, click **File > Edit > Preferences**. The Preferences window opens, and then click the **Capture** tab. Available options are as follows:

**Capture**

- **Add captured files to media library**: select this option to import captured files into the media library directly after capture.
- **Add captured files to workspace**: select this option to automatically import captured files into the editing workspace.
• **Use video overlay for capture**: keep this option selected during capture unless you have an older VGA card that does not support video overlay. Deselecting this option in this event avoids the unsupported overlay display errors.

• **Enable automatic file replacement when recording voice-over**: select this option to overwrite existing audio if the voice-over overlaps during recording.

• **Enable CyberLink MPEG@Best**: select to balance capture speed and video quality when you capture MPEG video.

**Auto scene detection**

• **Do not detect scenes during capture**: select this option if you do not want to activate the auto scene detection function during capture.

• **After capture, detect scenes by change of video frames**: select this option to perform scene detection during video capture. In scene detection, CyberLink PowerDirector compares captured frames to decide when there is a scene change. Each scene is saved as a file as recording continues.

• **During capture, detect scenes by time code, and then save each scene as a separate file (DV-VCR mode only)**: select this option to detect scene break signals and to save each scene as a separate file. (DV camcorders generate a scene break signal on the tape whenever users release the REC button.) This feature is only available in DV camcorder capture.

• **DV Parameters**: click this button to set the buffer parameters for your DV camcorder. Setting a buffer time ensures that your DV camcorder and your batch capture or DV writing device begin at the same time. Without a buffer, batch capturing or writing to tape may begin before the camcorder is engaged.

**Produce Preferences**

To set your production preferences, click ⚙ > Edit > Preferences. The Preferences window opens, and then click the **Produce** tab. The available options are as follows:

**Produce**

• **Output only selected tracks**: select this option to output only the selected tracks in the timeline. The tracks that are not selected are not produced during production.

• **Reduce video blocky artifacts (Intel SSE4 optimized)**: select this option to improve the production overall quality of produced video, if your computer supports Intel SSE4 optimization.
Quality of 3D slideshow:
• use the slider to set the quality of a produced 3D slideshow video. The slower the images move, the better the quality of the slideshow. When selected, CyberLink PowerDirector will use your computer’s 3D graphics card (if you have one) to accelerate the production time.

DirectorZone Preferences

To set your production preferences, click  Edit > Preferences. The Preferences dialog box opens. Click the DirectorZone tab. The available options are as follows:

Auto sign in
• Auto sign in to DirectorZone when PowerDirector is launched: select this option and then enter in your e-mail address and password to automatically sign in to DirectorZone when the program is opened. If you do not have a DirectorZone account, click on the Get an Account button.

Privacy rules
• Allow DirectorZone to gather editing information: select this option to allow DirectorZone to collect all of the names of the templates used in a finished project that is being uploaded to YouTube.
Chapter 4:

Creating Your Story

Now that you have all of your media ready, this chapter will guide you through the process of turning your collection of media into professional-looking videos and photo slideshows.

PowerDirector Projects

Each time you start working on a new production, you create a new project that is saved as a PDS file and is used exclusively by CyberLink PowerDirector. Use the buttons to save, create new or open existing projects within CyberLink PowerDirector.

The changes you make to your media in CyberLink PowerDirector do not affect the original media you imported into the program. Since your settings are all saved in the project file, you can trim, edit or delete clips, but still keep your original files on your hard drive, untouched. So let yourself get creative. If you end up changing things too drastically, you can always start over.

Setting Project Aspect Ratio

Before you start working on your project, you should set your project’s aspect ratio. The default aspect ratio is 16:9, which fully utilizes a widescreen TV or display device, as well as YouTube’s full video window. You can also revert back to 4:3 if required, just ensure that the aspect ratio of your media matches your project. To modify the aspect ratio for your media, see "Adjusting Video Clip Aspect Ratio" on page 53.

To set the aspect ratio for your project, click > Edit > Aspect Ratio > 4:3 or 16:9. The preview window changes according to the aspect ratio you select.

Adding Media to the Editing Workspace

Now you can begin putting your final production together by adding media and effects to the editing workspace. You can also use the Magic Movie Wizard or the Slideshow Designer to quickly create a production if you are short on time or to use as a guideline to get you started.
Note that you can only add certain media clips to specific tracks. For example, titles to the Title Track, transitions to the Transition Track, or audio to the Voice or Music Track. When you select a media clip, the tracks that you can add it to light up.

**Magic Movie Wizard**

If you are new to the editing process and not sure how or where to get started, then the Magic Movie Wizard can help. The Magic Movie Wizard takes all of your media and creates a dazzling video production in just a few steps. You can then edit the created production, output it to a file, or burn it to a disc.

**Note:** the Magic Movie Wizard provides the option of using all the media in the Media Library, all the media currently in the workspace or all currently selected media. If you only want to use a specific number of clips, select the clips you want to use before you begin.

To use the Magic Movie Wizard, click the button located to the left of the timeline and then follow the detailed steps provided in the wizard.

**Slideshow Designer**

The Slideshow Designer is the easiest way to take your photos and turn them instantly into a dynamic slideshow. Drag all the photos that you want in the slideshow into the timeline, make sure they are selected, and then click on the **Slideshow** button to launch the Slideshow Designer.

Within the Slideshow Designer you can select from a number of slideshow templates. Each template will create a completely different type of slideshow. Click **Next** to go to the preview window and see the outputted result. You can then return to the previous window and select another template if you like.

**Slideshow Music**

To add background music, click and then select the audio that you want to use.
Chapter 4: Creating Your Story

**Note:** if you select to include background music with your slideshow, CyberLink PowerDirector uses the Magic Slideshow technology to synchronize the photos along to the beat of the music during the slideshow.*

**Music Preferences**
If you are using background music in your slideshow, click on **Music Preferences** to configure the preferences as follows:
- trim the audio file using the playback controls and then move the sliders on the trim bar to the desired start and end points.
- during playback of the background music, click to mark the starting point of the music and then to mark the end point.
- select to have the background music gradually **Fade-in** or **Fade-out**.

**Slideshow Preferences**
Click on **Slideshow Preferences** to configure the preferences for your slideshow as follows:
- **Duration**: use this option to set the length of your slideshow. Select **Fit photos to music** for the length of the slideshow to match the duration of the selected music. Select **Fit music to photos** for the length of the music to match the duration of the auto created slideshow.
- **Sequence**: use this option to set the photo sequence for your slideshow. Select **Timeline order** to have the sequence match the order the photos are currently displayed in the timeline. Select **Date/time taken** for the photos to display in chronological order based on the date and time they were taken.
Customizing Slideshows in the Slideshow Designer

Some slideshow templates let you manually customize slideshows in the Slideshow Designer. Once the slideshow is created, if the Customize button is visible in the preview window or when the slideshow is selected on the timeline, click it to launch the Slideshow Designer.

A - Preview Area, B - Editing Area, C - Slide Area, D - Extra Tools Area

The editing options and tools that are available in the Slideshow Designer, depend on the slideshow template you selected. The following outlines the editing options for each of the templates in the Slideshow Designer.

Cell Slideshow

When customizing a cell slideshow in the Slideshow Designer, you can perform the following functions:

- in slide area, click on a specific slideshow slide to view and edit it.
- in the preview area, click and drag a photo to an alternative cell.
in the editing area (Unused photos), click the **Add Photos** button to import additional photos for use in the slideshow.

- in the editing area (Unused photos), indicate the maximum number of photos that are displayed on a slide.
- in the editing area, drag and drop the photos from Unused photos to the cell in the preview area where you want it on the slide. You can also highlight a cell by clicking it and use the **>** **<** buttons to add or remove selected photos.
- in the preview area, select a cell with a photo and then click on the **** button area to set the focus of that cell on a specific portion of the photo.
- in the extra tools area, click the **Remix** button to generate a new version of the slideshow.
- in the preview area, use the playback controls to preview the slideshow.

### 3D Slideshow

When customizing a 3D slideshow in the Slideshow Designer, you can perform the following functions:

- in slide area, click on a specific slideshow slide to view and edit it.
- in the editing area (Cropping area), resize and drag the box to the area of the photo you want highlighted in the 3D photo on the slide.
- in the preview area, use the playback controls to preview the slideshow.

### Highlight Slideshow

When customizing a highlight slideshow in the Slideshow Designer, you can perform the following functions:

- in slide area, click on a specific slideshow slide to view and edit it.
- in the extra tools area, select whether you want to edit the foreground or background photo.
- in the editing area (Cropping area), resize and drag the box to the area of the photo you want highlighted on the slide.
- in the preview area, use the playback controls to preview the slideshow.

### Motion Slideshow

When customizing a motion slideshow in the Slideshow Designer, you can perform the following functions:

- in slide area, click on a specific slideshow slide to view and edit it.
• in the editing area (Cropping area), use the Magic Motion Designer to customize the motion on the slide. See "Magic Motion Designer" on page 55 for more information.
• in the preview area, use the playback controls to preview the slideshow.

**Adding Video, Photos and Audio to the Workspace**

The sections below outline the procedures for adding each kind of media into the editing workspace.

---

**Note:** you may prefer to add clips in storyboard view, since this view is simpler than the timeline view. However, you can only add clips to the Master Video Track in this view. Therefore, this section uses the timeline view in all of the procedures.

---

**Adding Video Clips and Photos**

You can add video clips and photos to either the Master Video Track or a PiP (picture-in-picture) Track.

---

**Note:** you can add additional PiP tracks to your project’s timeline in the Track Manager, allowing you to have up to nine PiP objects displayed on a video at the same time. See "Track Manager" on page 19 for more information.

---

To add video clips or photos to the workspace, do this:

• select the clips and then click ![Add to Master Video Track](image) to add them to the Master Video Track or ![Add to PiP Track](image) to add them to a PiP Track.
• drag clips to a desired position in the Master Video or a PiP Track. When adding clips to the Master Video Track, you cannot leave an empty gap between adjacent clips. Clips added to the end of the Master Video Track follow immediately after the final clip in that track.

---

**Note:** you may select several clips and drag them together into the same track, provided that all of the clips are compatible with the destination track.
• right-click on a clip and select **Add to Video Track** or **Add to PiP Track** as required.

To create the basic framework of your video, add video clips and photos to the Master Video Track. Add media to the PiP track to create a picture-in-picture effect.

---

**Note:** use the PiP Designer to customize the PiP effects in your video production. See "Modifying PiP Effects in the PiP Designer" on page 58 for more information.

---

### Adding Color Boards

The use of color boards allows you to insert solid frames of color into your video. Color boards are really useful as quick transitions between video clips or as background for titles and ending credits.

To add a color board to the timeline, click on and then select the **Color Boards** folder, or select from the library drop down menu.

**Note:** you can add color boards to either the Master Video or PiP Track.

---

### Adding Audio Clips

Audio clips allow you to add background music or a narrative voice-over to your video. CyberLink PowerDirector provides up to four tracks for audio (three music tracks and one voice track), which you can use interchangeably.

**Note:** you can add additional music tracks to your project’s timeline in the Track Manager, allowing you to have up to three pieces of music playing in your video at the same time. See "Track Manager" on page 19 for more information.

To add audio to the workspace, do this:

• select an audio clip and then click  to add it to the Voice Track or  to add it to the Music Track.

• drag one or more audio clips to a desired position in the Voice or Music Track. Audio clips can be added at any point in this track.

• right-click on a clip and select **Add to Voice Track** or **Add to Music Track** as required.
Note: you can only add audio files to the workspace in the timeline view. If you drag an audio file to the workspace in the storyboard view, the workspace automatically switches to the timeline view.

**Adding Video Effects, PiP Objects, Particle Effects, Titles and Transitions**

The sections below describe the procedures for adding video effects, PiP objects, particle effects, titles and transitions into the workspace.

Note: if required, you can download and import additional PiP objects, particle effects and titles from DirectorZone. See "Downloading Templates from DirectorZone" on page 23 for more information.

**Adding Video Effects**

To add a video effect to a *portion of a clip* in the timeline, do this:

- select an effect and then click ![Effect Track](image) to add it to the Effect Track at the current position of the timeline slider.
- drag an effect from the Effects Room into the Effect Track directly beneath the clip(s) in the Master Video Track that you want to apply it to.
- right-click on an effect and select *Add/Replace in Timeline* to add or replace the Effect Track at the current position of the Timeline slider as required.

You can add a random video effect at the current position of the Timeline slider by clicking ![Random Effect](image) and then selecting *Add Random Video Effect*.

Note: click the *Modify* button to edit the effect’s options. See "Modifying a Video Effect" on page 57.

To add a video effect to an *entire clip* in the timeline, do this:

- select an effect, drag it to the Master Video Track and then drop it on top of the clip you want to apply it to. The video effect is applied to the entire duration of the clip.
Adding PiP Objects
To add a PiP object to the timeline, do this:

- select an object and then click to add it to the PiP Track at the current position of the timeline slider.
- drag an object from the PiP Objects Room into the desired position in the PiP track.
- right-click on an object and select Add/Replace in Timeline to add or replace the object at the current position of the Timeline slider as required.

Once you add objects to the PiP Track, click the Modify button to edit its placement, motion and more in the PiP Designer. See "Modifying PiP Effects in the PiP Designer" on page 58 for more information.

Adding Particle Effects
To add a particle effect to the timeline, do this:

- select an particle effect and then click to add it to the PiP Track at the current position of the timeline slider.
- drag a particle effect from the Particle Room into the desired position in the PiP Track.
- right-click on an object and select Add/Replace in Timeline to add or replace the particle effect at the current position of the Timeline slider as required.
**CyberLink PowerDirector**

**Note:** you can download additional particle effects from the DirectorZone web site. See "Downloading Templates from DirectorZone" on page 23 for more information.

Once you add a particle effect to the PiP Track, click the **Modify** button to edit its properties in the Particle Designer. See "Modifying Particle Effects in the Particle Designer" on page 64 for more information.

**Adding Title Effects**
To add a title effect to the timeline, do this:

- select a title template and then click the button to add it to the Title Track at the current position of the timeline slider.
- drag an effect from the Title Room to the desired position in the Title Track.

You can add a random title effect at the current position of the timeline slider by clicking and then selecting **Add Random Title Effect**.

**Note:** you can download additional title templates from the DirectorZone web site. See "Downloading Templates from DirectorZone" on page 23 for more information.

Once you add a title template to the Title Track, click the **Modify** button to edit it in the Title Designer. See "Modifying Title Effects in the Title Designer" on page 66 for more information.

**Adding Transitions**
To add a transition to the timeline, do this:

- select a transition effect and then drag it to between the clips in the Master Video Track where you want it applied.

**Note:** you can manually set the duration of the transition. See "Setting Clip Duration" on page 49 for more information.

To add random transitions to **all clips** in the timeline:

- click on a transition and then on the button to add a random transition to all clips in the timeline.
Chapter 4: Creating Your Story

• click on a transition and then on the button to add the fading transition to all clips in the timeline.

Click on in the library window and selecting Apply Random Transition Effect to All or Apply Fading Transition to All.

Editing Your Media

Once you have your media in the editing workspace you can perform edits and refinements to it. Editing is a broad term that encompasses a number of different functions: you can, for example, trim unwanted sections from video or audio clips, increase or decrease the speed of a video clip, or fix and touch up your videos and photos. This section describes all of the editing processes that you can perform on the different types of media clips.

Note: the functions in this section can only be performed in timeline view.

Splitting a Clip

When a single media clip is selected on the timeline, click Split to separate it into two clips at the current position of the timeline slider. Use this feature to quickly remove unwanted portions of a clip or to insert color boards or other media.

Note: if required, select the two split portions, right-click and then select Combine to merge them back together.

Trimming Video and Audio Clips

Captured video and audio clips sometimes contain unwanted portions at the beginning, in the middle, or at the end. These unwanted portions are easily removed in CyberLink PowerDirector using the trim functions.

Note: trimming a video or audio clip does not delete any portion of the original content.
Performing a Multi Trim

You can trim all your video clips using the Multi Trim function. Multi Trim lets you trim out one or more portions of a video clip at once, resulting in clips that are independent from the original video. You can also detect scenes using the Multi Trim tool.

A - Preview Area, B - Timeline Magnifier*, C - Timeline, D - Magnified Timeline, E - Trimmed Portions Area, F - Magnifier Tools*, G - Trimming Tools, H - Playback Controls, I - Frame Display

Note: * optional features in CyberLink PowerDirector. Check the readme file for detailed versioning information.

To perform a trim on a video, select the video clip on the timeline that you want to trim and click Multi Trim. Within the Multi Trim window, you can perform the following functions:
• use † and ‡ in magnifier tools to set the magnification level on the video clip. The size of the timeline magnifier will change based on the magnification level selected.
• drag the timeline magnifier along the timeline to find the section of video you want to trim.
• use the timeline slider to find the starting and end points of your video clips that you want to trim. You can also use the playback controls to find the exact frames in the frame display area.
• click on ■ in the trimming tools to mark the starting point of a trim, and ■ to mark the end point.

**Note:** the portions of video that CyberLink PowerDirector will insert into the timeline are indicated in blue. If currently it is these sections that you want to omit from the timeline, click the Invert button in the trimmed portions area.

• move the timeline slider over a trimmed portion and click the ■ button in the trimming tools to split it into two clips.
• click on ■ in the trimming tools to detect all the scenes in your video clip. You can then choose to just mark them on the timeline or have CyberLink PowerDirector automatically trim them for you.

**Trimming Audio/Video Clips**
To trim an audio/video clip, select the clip on the timeline that you want to trim and then click Trim.

Within the trim window, you can perform the following functions:
• use † and ‡ to decrease or increase the magnification level on the clip.
• use the timeline slider or the playback controls to find the starting and end points of your clip that you want to trim.
• click on ■ to mark the starting point of a trim, and ■ to mark the end point.

**Setting Clip Duration**
Within the timeline click the Duration button (or right click on the clip and select Set Duration) to set the amount of time photos, title effects, and PiP media are displayed, or how long a transition takes to complete.
You can also change the duration of the above mentioned media or for trimmed video clips, by selecting the clip and then dragging the end of the clip to the desired duration.

**Note:** you can only lengthen a video clip back to its original duration and transitions to half the duration of the shortest clip they affect.

## Muting Media Clips

If you want to mute the audio portion of an a media clip, right-click on it and then select **Mute Clip**. Any audio volume keys you added previously are hidden.

To restore sound to the track, right-click the track and deselect **Mute Clip**.

**Note:** if you would like to mute the audio of an entire track, right-click on the track and then select **Mute Track**. This is sometimes useful if you have placed video on a PiP track and you don’t want any of it’s audio in your final production.
**Editing Images**

Select an image on timeline and then click the **Edit Image** button* to edit it within CyberLink PhotoNow!. Please consult the help file within PhotoNow! for detailed information on editing images in that program. Once you finish editing an image, the updated file is placed on the timeline.

---

**Note:** * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

---

**Fixing and Enhancing Photos/Videos**

Select the **Fix/Enhance** button when media in the timeline is selected, to perform various edits on your photos and videos, including video denoise and enhancements.

With the **Video Enhancement** feature, you can upscale video using TrueTheater HD technology from CyberLink. Click on the **i** button to consult the iHelp for information on using these features.

---

**Power Tools**

Select a video on the timeline and then select the **Power Tools** button to perform a range of powerful functions, including:

- **Video in Reverse:** when enabled on a selected video clip, it will play in backwards.
- **Video Crop:** select this option to crop or zoom in on a specific portion of a video clip. Select the **Crop Video** button to define the area you want to zoom in on (crop). You can then customize motion on the cropped portion of video. See "Magic Motion Designer" on page 55 for information on customizing the motion on the cropped section of video.
- **Video Speed:** select this option to change the speed of a video clip. Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a video. For an advanced slow motion effect, use the **Slow motion video with frame interpolated technology** option. Select **Stretch audio** (between 2X and 0.5X only) to stretch the audio to match the new video’s length. Deselect this option to mute the audio. You can also enter a
new duration in **New video length** video to manually increase/reduce a video clip's speed.

- **Video Rotation**: use this function to rotate video up to 270 degrees in the clockwise direction.

**Freeze Frame Effect**

Select a video clip on the timeline and then click the **Freeze Frame** button to instantly create a freeze frame effect. CyberLink PowerDirector takes a snapshot of the current frame of video and then inserts it into the timeline, along with a video effect and title template, creating a freeze frame effect. Edit the inserted photo and effects to your specification to ensure the freeze frame effect fits your creation.

You can choose to not have CyberLink PowerDirector insert the effects by deselecting the option in preferences. See "Editing Preferences" on page 33 for more information.

**Time Info**

When a RichVideo video clip or an EXIF image is added to the timeline, the **Time Info** button is enabled. Click the **Time Info** button to enable the date caption or time code that was captured from the original camcorder or digital camera. You may also add a text remark to your video or image if required.

**Setting Video Clip Interlacing Format**

All video clips have an interlacing (TV) format, which specifies how frames are displayed. Using video clips with conflicting (or incorrect) TV formats can result in degraded video quality in your final production.

Before you produce your video, set all of the video clips to the same format. While CyberLink PowerDirector can normally detect and suggest the correct format, some interlaced video (such as a video with very little motion) may be misjudged as a progressive video.

CyberLink PowerDirector automatically produces interlaced video for DVD, SVCD and DV-AVI. Only change this setting if you are sure that CyberLink PowerDirector has wrongly set the format.


**Note:** this is an extremely important step to take before production, as it can drastically affect final video quality.

To set a video clip’s TV format, right-click the video clip whose interlacing format you want to set and select **Set TV format**.

**Adjusting Video Clip Aspect Ratio**

Video clips usually come in one of two aspect ratios, 4:3 or 16:9. Depending on your media clips and the medium you will be using to view your video, you can adjust your video’s aspect ratio accordingly. Before you produce your video, set the aspect ratio for all of the video clips so that it matches the aspect ratio of your project.

Depending on the aspect ratio of your project and the aspect ratio of your clips, you have two options to choose from.

If your project aspect ratio is 4:3 and you wish to produce video with clips that have a 16:9 aspect ratio, right-click on the video clip you want to adjust and select **Set Aspect Ratio**.

**Using Magic Tools**

CyberLink PowerDirector offers a number of magic tools that can assist you to edit and touch up your audio, video and image clips. The magic tools can also help you add a creative style to your video production or add the right background music. CyberLink PowerDirector offers the following Magic Tools:

- **Magic Movie Wizard:** automatically creates an edited video blended with stylish effects and transitions.
- **Magic Fix:** fixes and enhances your photos and videos, including fixing shaky video, enhancing video quality, removing red-eye, and enhancing the focus on photos.
- **Magic Motion:** applies zooms and pans to your images. You can also use the Magic Motion Designer to manually customize motion on an image.
- **Magic Cut:** condenses long video segments into shorter clips that contain only the best moments.
- **Magic Style:** creates professional videos with pre-designed style templates automatically.
• **Magic Music**: adds background music that automatically adjusts to suit different durations.

---

**Note:** *optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.*

---

To access the magic tools, click the icons to the left of the timeline, or click **Edit > Magic Tools.**

### Magic Movie Wizard

If you are new to the editing process and not sure how or where to get started, then the Magic Movie Wizard can help. The Magic Movie Wizard takes all of your media and creates a dazzling video production in just a few steps. You can then edit and refine the created production in the editing workspace, output it to a file, or burn it to disc. See "Magic Movie Wizard" on page 38 for more information on using this feature.

### Magic Fix

With Magic Fix you can stabilize videos taken with shaky hands, enhance a video’s audio, or the quality of a video’s image. You can also use this tool to remove red-eye from photos, or to improve the focus on photos that are out of focus. Click on the button to consult the iHelp for more information on using these features.

### Magic Motion

CyberLink PowerDirector’s Magic Motion tool adds zooms or pans to images, creating a motion effect in your final video. The Magic Motion tool is ideal for turning slideshows into engaging presentations, especially when combined with Magic Music. Select from a number of motion templates for each photo in your project and use the Magic Motion Designer to customize the motion to your liking.
Magic Motion Designer

After you select a motion template to apply to the selected photo, select the **Motion Designer** button to customize the motion in the Magic Motion Designer.

The Magic Motion Designer uses keyframes to customize the motion on a photo. Keyframes are frames of your video that define the start and end points of an effect, which in this example is motion or the size of the focus area.

In the Magic Motion Designer you can:

- use the playback controls or drag the slider to preview the current motion in the preview window.

- click on ✡ to add keyframes to the motion path. By adding keyframes you can alter the motion or size of the focus area between two points on the keyframe timeline.
• click on to duplicate the previous or next keyframe on the keyframe timeline. Doing this will copy the properties of the indicated keyframe to the new position.
• resize the focus area to define the part on the photo you want to highlight or focus on.
• click and drag the motion path to alter the movement of the focus area.
• add a rotation effect on the focus area by entering the rotation amount in the field provided and then clicking . You can also click and drag to rotate the focus area manually.
• click on to to zoom in or out. Zooming in is useful for precise movement of motion, while you can zoom out if you want to start the motion off screen.
• click on to use the TV safe zone and grid lines to help with the precise movement of the focus area on the image. Select Snap to Reference to have the focus area snap to the grid lines, TV safe zone and boundary of the video area.

Magic Cut

Magic Cut auto-edits your video clips using “magic” video technology to locate and keep the most interesting moments, while discarding sections of lesser importance. The Magic Cut tool is ideal for condensing long video segments into shorter clips. For example Magic Cut can edit a one hour video down to ten minutes.

Note: if the video clip you are using is shorter than 15 minutes in length, was previously edited, or contains extremely important moments, you may prefer to edit it manually using the Multi Trim function. See "Performing a Multi Trim" on page 48.

Magic Style

With Magic Style you can automatically create professional looking videos that use pre-designed style templates. Magic Style includes pre-designed opening sequences, transitions and effects to automatically generate professional-looking videos on your timeline. It is perfect for use when you want
Chapter 4: Creating Your Story

to create great looking videos without the hassle of setting up the opening title, video effects and transitions yourself.

**Magic Music**

With Magic Music* you can use music supplied within CyberLink PowerDirector or purchase and download additional tracks, in your video.

---

**Note:** * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information. Click the **SmartSound** button to view SmartSound-related copyright and purchasing information.

---

The Magic Music tool is ideal for use with photo slideshows.

**Modifying Effects**

Most of the effects within CyberLink PowerDirector are completely customizable. In fact, this section describes some of the most creative functions found within the CyberLink PowerDirector program.

**Modifying a Video Effect**

Many video effects let you customize its properties, such as the intensity or other random settings, using keyframes and various sliders. Video effects only affect the clips in the Master Video Track that appear within the effect’s duration.

To modify a video effect, double click on it or select it and then click **Modify** (To modify a video effect that is applied to the entire clip, select the clip and then click **Effect**). The type of modifications that are available in Effect Settings depend on the effect you selected.

Some effects use keyframes to customize the effect properties. Keyframes are frames of your video that define the start and end points of an effect, for example the intensity of an effect between two keyframes.

- use the playback controls or drag the slider to preview the current effect properties in the preview window.
- click on 🔵 to add keyframes. By adding keyframes you can alter the effect properties between two points on the keyframe timeline.
**Note:** to remove an effect applied to an entire clip, deselect the effect name within the Effect Settings window.

### Modifying PiP Objects

When you insert an object from the PiP Objects Room into the PiP Track, it has all of the same properties as any other PiP photo or video. You can resize, reposition, and modified objects by adding shadows, chroma key effects, and more.

### Modifying PiP Effects in the PiP Designer

A PiP (picture-in-picture) effect allows you to insert an image, video or object onto an existing image or video clip in your video, effectively overlaying a picture-in-picture within the existing clip. You can modify the degree of transparency of the
overlapping clip, as well as its position, motion and other properties using the PiP Designer.

A - Upload to DirectorZone, B - PiP Effect Properties Tab, C - PiP Effect Properties, D - Motion Tab, E - Save Custom Template, F - PiP Masks Tab, G - PiP Object, H - Master Video, I - TV Safe Zone/Grid Lines, J - PiP/Keyframe Timeline

To open the PiP Designer:
- select an item on the PiP Track and then click Modify.
- within the PiP Objects room, click on to create a new PiP object template from scratch by importing a custom image.
- within the PiP Objects room, select an existing PiP object and then click on to edit the existing template.

**Modifying PiP Effect Size and Position**

You can change the size, position and orientation of the media clip or object in a PiP effect. Resizing options are unrestricted. You can reduce the clip to miniature size or enlarge it to completely obscure the underlying media file.
Note: click on \(...\) to use the TV safe zone and grid lines to help with the precise movement of the PiP effect on the master video. Select Snap to Reference to have the PiP effect snap to the grid lines, TV safe zone and boundary of the video area.

To modify its size, position or orientation:
- click and drag a corner or side to resize the PiP object.

Note: deselect Maintain aspect ratio to resize the PiP object more freely.

- click on the PiP object and drag it to a new position.
- click on \(...\) above the PiP object to change its orientation.

Modifying PiP Effect Properties
Within the PiP effect properties tab, you can:
- select the check box and then click on \(...\) to add a chroma key effect to your PiP object. Within in the chroma key window, select a color within the picture or video clip, and then use the intensity slider to reveal the image or video behind it. In effect, the selected color becomes transparent.
- select the check box and then click on \(...\) to add a shadow to the clip or object in a PiP effect. Available options allow you to change the shadow’s color, direction, and distance from the PiP effect. You can also set the transparency and blur levels of the shadow using the available sliders.
- select the check box and then click on \(...\) to add a border around the clip or object in a PiP effect. Available options allow you to change the color, direction and size of the border. You can also set the transparency and blur levels of the border using the available sliders.
- select Enable flip object to flip the PiP object upside down or from left to right, depending on your selected preference.

Adding Motion to PiP Effects
Within the PiP motion tab you can add motion* to a PiP effect, allowing it to move across the screen. You can choose from a number of predefined motions or create your own custom PiP motion. You can also set the transparency level of the PiP effect, rotate the effect, and add a fade-in or fade-out effect.
Note: * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

Adding PiP Effects With Predefined Motion
To add a predefined motion to a PiP effect, click on the motion tab to display the PiP motion options and then select a predefined motion from the available list.

Customizing PiP Effect Motion
The PiP Designer uses keyframes to customize the motion on a PiP effect (and transparency if required). Keyframes are frames of your video that define the start and end points of an effect, which in this example is motion or transparency.

Note: some objects have predefined motion already applied.

To customize the motion of a PiP effect:
- drag an existing keyframe to a new location in the preview window. The PiP effect will move along the new path to get to the changed keyframe.
- drag the path line to alter the path the PiP effect will take to get to the next keyframe.
- click the add keyframe button to add a new keyframe where required.
- click on to duplicate the previous or next keyframe on the keyframe timeline. Doing this will copy the properties of the indicated keyframe to the new position.

Customizing the Speed of PiP Effect Motion
You have full control over the speed to the PiP effect’s motion. The following three factors determine the speed of the PiP effect’s motion.

Duration of the PiP clip in the timeline
The longer the PiP clip, the slower the PiP object’s motion will be. For example, if the PiP clip is 10 seconds, it will take the PiP effect 10 seconds to complete the applied motion.

Distance between keyframes
The distance between each keyframe also contributes to the speed of the PiP effect motion. The further the distance between each keyframe, the quicker the PiP effect will have to move to get to the next keyframe.

**Keyframe timeline**
The keyframe timeline is located below the preview window. Each keyframe in the motion path has a corresponding marker on the keyframe timeline.

If the PiP clip on the timeline has a duration of 10 seconds, the keyframe timeline will be 10 seconds long. To increase the speed of a PiP effect’s motion, drag a keyframe marker closer to previous keyframe marker.

**Setting PiP Effect Transparency**
You can set the level of transparency of the PiP effect in the PiP Designer by using the transparency slider to set your desired level of transparency for your effect.

*Note:* Use keyframes to control the transparency of your PiP effect.

**Customizing PiP Effect Rotation**
To customize the rotation of a PiP effect, enter in the degree of rotation in the **Rotation settings** section you want the PiP to rotate in the available box, then choose whether:

- to rotate the PiP effect counter clockwise
- to rotate the PiP effect clockwise

**Saving and Sharing PiP Templates**
Once you finish modifying your PiP template you can save it to the PiP Objects Library for future use or upload it to DirectorZone to share it with others.

- click on **Share** to upload your custom template to DirectorZone.
- click on **Save** to upload the modified template to your PiP Objects Library.
- click on **File** to save a modified PiP effect’s motion path as a custom path.
Adding PiP Effect Masks

Within the PiP masks tab you can use masks to overlay portions of the PiP effect or master video. Masks are useful if you want to show/hide portions of the master video or PiP effect on the final production. Use the transparency slider to set the transparency level for the mask if required.
Modifying Particle Effects in the Particle Designer

A particle effect allows you to insert particle objects (snow, dust, etc.) onto an existing image or video clip in your video, effectively overlaying a picture-in-picture effect on the existing clip.

You can completely customize the particle object properties using the Particle Designer.

To open the Particle Designer:

- select an particle effect on the PiP Track and then click **Modify**.
- within the Particle Room, click on to create a new Particle effect template from scratch by importing a custom image.
• within the Particle Room, select an existing particle effect template and then click on [icon] to edit the existing template.

Modifying Particle Object Range and Position
You can change the range, position and orientation of each particle object. Increase the range of the particle object to cover more of the background (master video), or modify the position or direction particles fall/emit from their source point.

**Note:** click on [icon] to use the TV safe zone and grid lines to help with the precise movement of the particle objects on the master video. Select **Snap to Reference** to have the particle effect snap to the grid lines, TV safe zone and boundary of the video area.

To modify its range, direction, position or orientation:
• select the particle object that you want to modify, and then click and drag [icon] to the desired result.
• click on [icon] and drag it to a new position.

Adding Particle Objects and Background Images
You can add additional particle objects to a particle effect template or insert a custom background image. To do this, click on [icon] and then select what you want to do from the list. If you add a new particle effect, the particle object properties area opens. If you import a background image, it will replace the current background completely.

Editing Particle Object Properties
To edit a particle object’s properties, select it and then click on [icon].

**Note:** if you select the background image to edit, the only option available is to replace it with a different image.

Within the particle object properties tab, you can:
Select emit method: select how the particles emit from the source point. You can have them emit from a single point, from a line, or spray out in a circle. You can also import an image to create a masked area where particles emit from. Depending on the mask you import and how you resize it, the particles will emit differently.

Select particle style: select the style of the particle object. Depending on the property you select, the particle shape and behavior will change. Select the style that best suits the effect you are trying to accomplish.

Add/Delete particle: within this section you can click on and then import an image to create custom particles. You can add as many custom particles as you like, or select an existing particle and then click to delete it from the particle object.

Modify parameters: within this section you can completely customize the properties of the particle object. Everything from the particle emit rate (number of particles being emitted from the source point), speed of the particles, display time (life time), size, wave (path) and rotation. Set all of the parameters to best suit the effect you are trying to accomplish.

Adding Motion to Particle Objects

Within the particle object motion tab you can add motion to a particle object, allowing the particle’s source to move across the screen. You can choose from a number of predefined motions or create your own custom motion. The motion properties of a particle object is similar to a PiP object. See "Adding Motion to PiP Effects" on page 60 for detailed information on customizing a particle object’s motion.

Saving and Sharing Particle Effect Templates

Once you are finished modifying your particle effect template you can save it to your Particle Effects Library for future use or upload it to DirectorZone to share it with others.

- click on Share to upload your custom template to DirectorZone.
- click on Save to save the modified template to the Particle Room.

Modifying Title Effects in the Title Designer

Using title effects allows you to add text to your video - as a title at the beginning, an element during the main story, or as credits at the very end. Besides changing
the look of the text itself, you can also send the text running on a path across the screen. Title effects only affect the clips in the Master Video Track that appear within the title’s duration.

Title effects contain character presets, animation and background options, which you can modify to best suit your video. All of these options are found in the Title Designer.

To open the Title Designer:
- select a title effect in the Title Track and then click Modify.
- within the Title room, click on to create a new title template from scratch.
- within the Title room, select an existing title effect and then click on to edit the existing template.

To add additional content to your title in the Title Designer:

A - Upload to DirectorZone, B - Text Properties Tab, C - Title Properties, D - Animation Properties Tab, E - Save Custom Template, F - Background Properties Tab, G - Title Effect, H - Master Video, I - TV Safe Zone/Grid Lines, J - Title/Keyframe Timeline
• click on \[T\] to add additional text to a title effect.
• click on \[\] to add images that accompany the text.

**Modifying Title Effect Position**

You can change the position and orientation of the titles in a title effect quickly and easily.

**Note:** click on \[\] to use the TV safe zone and grid lines to help with the precise movement of the title effect on the master video. Select **Snap to Reference** to have the title effect snap to the grid lines, TV safe zone and boundary of the video area.

To modify its position or orientation:
• click on the title and drag it to a new position.
• click on \[\] above the title to change its orientation.

**Modifying Text Properties**

Within the text properties tab, you can modify everything from the text size, style, color, as well as adding shadows and borders. To modify the text font style, size, weight or alignment, simply use the available options above the preview window.

**Applying Character Presets to Title Effects**

You can apply a defined character preset to a title effect. After you have applied the defined character preset you can go to font face, shadow or border settings to make changes to the title effect if required.

To apply a character preset to a title effect, click the text properties tab and then click \[Aa\]. Click on the text in the preview screen that you would like to change and then click on a character preset from the available list.

**Customizing Text Font Face**

You can customize the font face settings of the title text, including the color, and adding blur and transparency effects. To customize a title effect’s font face, click on the text properties tab and then on \[\].
Adding Shadows to Title Text
You can add a shadow around the text in a title effect. Available options allow you to change the shadow’s color and size, distance from the text, and add a transparency or blur effect. To add a shadow to a title effect, click the text properties tab and then click.

Adding Borders to Title Text
You can add a border around the text in a title effect. Available options allow you to change the border’s color, size, and add a transparency or blur effect. When adding a border to a title effect, click the text properties tab and then click.

Applying Animation to a Title Effect
You can apply animations to a title effect, such as text fades, movements or wipes. You can also edit any imported images in the animation properties tab.

To apply animation to text, click on the animation properties tab, select the text object you wish to animate in the list, or click on the object in the preview window. You can then:
• click Starting Effect and select a starting animation effect from the available list.
• click Ending Effect and select an ending animation effect from the available list.

To edit an imported image, select the image object in the list or click on the object in the preview window. You can then add a chroma key effect on the image, or flip the image upside down or left to right.

Customizing the Speed of Title Effect Animation
You can modify the speed of a title effect’s animation. The following two factors determine the speed for the animation to complete.

Duration of the title effect clip in the timeline
The longer the duration of the title effect clip in your project’s timeline, the longer it will take for the title effect animation to complete. For example, if the title effect clip is 20 seconds, it will take the title effect 20 seconds to complete the beginning and ending animation.

Keyframe timeline
The keyframe timeline is located below the preview window. The title effect animation has four keyframes.

The first two keyframes indicate the start and end points for the beginning effect, while the last two indicate the start and end points for the ending effect. If you would like to change the start or end time of the effect or how long it takes for the beginning or ending effect to complete, just drag a keyframe to the desired position in the timeline.

Note: the orange line indicates how long the title effect displays on screen once the beginning effect animation is complete.

**Adding Background Images to Title Effects**

You can add your own background images to a title effect. The background image is added to the entire title effect and will overlay the content from the Master Video Track.

To apply a background image to a title effect, click the background properties tab and select the background you wish to use from the list.

Note: if you don’t see a background image you like you can import your own image. Click  to import a custom image.

**Saving and Sharing Title Templates**

Once you finish modifying your title template you can save it to your Title Effects Library for future use or upload it to DirectorZone to share it with others.

- click on **Share** to upload your custom title template to DirectorZone.
- click on **Save** to save the modified template as a new template in your Title Room.
- click on  to save a customization you made to title text as a new character preset.
Mixing Audio and Adding Voice Overs

Your production’s audio can make or break your creation. Use the Audio Mixing Room to customize your audio levels or record a voice over to add narration to your video production.

Splitting Audio from a Video Clip

To make it easier to work with the audio of a video clip, you can split the audio from it and insert it into the Voice Track.

To split the audio from a video clip, right-click on a video clip in the timeline and select Split Audio. The audio will move from the Master Video Track to the Voice Track.

Note: the Split Audio function does not extract the audio from the video clip as a separate file. To extract the audio from a video clip, see "Extracting Audio from a Video Clip" on page 30.

Change Audio Clip Volume Levels

Your video production may contain audio in one of the music tracks, the Voice Track, and in the video clips in the Master Track. Since all of these tracks may have been recorded at different levels, the result could produce an overwhelming and confusing sound track.

Use the Audio Mixing Room to mix all of the audio levels into a more harmonious sound track for your video.

In-Track Audio Mixing

You can manually change the level of volume at any point within an audio clip in the Timeline.

To change the volume level of an audio track in the timeline, click on the audio level line at the point where you want to change the audio level to set a volume
key. Drag the volume key up to increase the volume or down to decrease the volume.

**Note:** to remove a volume key, drag it outside the clip's borders.

**Mix Audio Levels in the Audio Mixing Room**

Use the audio mixer in the Audio Mixing Room for precise control over the volume levels of the audio clips in the editing workspace. The audio mixer contains audio mixing controls for all of the audio tracks in the editing workspace.

When you enter the Audio Mixing Room, the audio at the current position of the timeline is available for mixing. Use the playback controls to locate the position in your video where you want to mix the audio.
• use the music audio volume control sliders to increase or decrease the volume of the track at a specific moment.
• use the music gain control sliders to increase or decrease the volume of the entire track.

**Note:** if there is more than one PiP or music track in timeline, use the PiP and music track selectors to select the desired track that you want to mix the audio for.

---

**Adding Fade Effects to Audio Clips**

To add a fade-in/fade-out effect to an audio clip, click on the point in the audio you want the fade effect to begin and then:

• click 🎧 to add a fade-in effect.
• click 🎨 to add a fade-out effect.

**Restoring Audio Clip Volume Levels**

If you are dissatisfied with the volume level of any audio clip after manually adjusting the levels, you can easily restore the clip’s original volume level. To do this, right-click the audio clip and then select **Restore to Original Volume Level**. Any audio volume keys you added are removed.
Record a Voice-Over

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching a preview of your video production. When you capture your narration, the audio track is automatically synchronized with the video portion.

Set your voice-over preferences as follows:

- select **Device** to select your audio device and input.
- select **Profile** to set up the audio quality.
- select **Preferences** to set a recording time limit or 3 second delay before recording begins to ensure you are ready to record. You can also set auto fade ins and outs.
- select whether to set a fade-in or fade-out effect on the voice-over:
  - click **A** to add a fade-in effect or **D** to add a fade-out effect.
• click  to begin recording. Record your voice-over as you watch the video in the preview window. click  to stop recording.

**Chapters**

Chapters are used to ease navigation of your finalized production when burned to a disc, allowing viewers to watch only the content they want or easily find their place if the disc was stopped before completion.

---

**Note:** if you choose not to include chapters, your video will play automatically when the disc is inserted into a player.

---

**Setting Chapters**

To set chapters, in the Chapter Room do one of the following:

• to set a chapter at the beginning of each video clip, click .
• to set chapters at fixed intervals, enter an interval (in minutes), then click .
• to set a specified number of chapters evenly on your disc, enter the number of chapters in the entry box, then click .
• to set chapter points manually, navigate to a location on the timeline, then click .
• to remove a chapter point, select it and then click .
• click  to remove all of the chapter points you have set.

**Setting Chapter Thumbnails**

You can customize the thumbnail image for each of your chapters, which are displayed on the disc menu on a finalized disc. Just click on  when the frame in the preview window is the one that you want to set as the chapter thumbnail.
Subtitles
CyberLink PowerDirector lets you add subtitles to your video production, either for a disc or imprinted on a video file. You can import subtitles from a text file or add them manually within the Subtitle Room.

To add a subtitle to your video production, click on in the Subtitle Room and then select one of the following types of subtitles:

- **Create subtitles for a DVD/BDMV/AVCHD**: selecting this option creates subtitles that are compatible with most DVD/BDMV/AVCHD playback software and can be switched on/off like those found on commercial discs.

**Note:** when you select **Create subtitles for a DVD/BDMV/AVCHD**, there is a Subtitles option by default in your created disc menu when created within CyberLink PowerDirector. Text formatting for disc subtitles is more limited.

- **Create subtitles imprinted on a video file**: select this option to blend subtitles into the video.

Adding Subtitles
To add a subtitle to your video production, you can:

- use the playback controls to locate the beginning point of each piece of dialogue that corresponds with the subtitle and then continually click the button to add a subtitle entry for each. When you click the stop button, the subtitle entries are loaded into the subtitle window.
- click the button to add a single subtitle entry.

Editing Subtitles
To edit a subtitle in your video production, you can:

- double-click on the subtitle marker in the timeline or in the Subtitle list view, and then enter the text as required.
- format the subtitle text as required by clicking the button.
- to remove a subtitle, select the subtitle marker and then click the button.
Chapter 4: Creating Your Story

Note: to export your subtitles and save them as an SRT file, click .

Importing Subtitles from Text Files
You can import subtitles from a text file in the SRT or TXT formats by clicking on . This allows you to compose your subtitles outside the program or retrieve them from another source and import them into CyberLink PowerDirector.

Note: when an SRT file is imported, the subtitles are created automatically in CyberLink PowerDirector. However, for TXT files you must first input all of the subtitle markers.

Syncing Subtitles with Dialogue
To ensure that the subtitles in your video production sync with the video dialogue, CyberLink PowerDirector provides a number of options for specifying the location.

To set a starting time for a subtitle, do either of the following:
• enter a time code in the Start Time column for the subtitle.
• position your cursor at the beginning of the subtitle marker on the Subtitle Track and drag the front of the clip to the new position.

To set an ending time for a subtitle, do either of the following:
• enter a time code in the End Time column for the subtitle.
• position your cursor at the end of the subtitle marker on the Subtitle Track and drag the end of the clip to the new position.
CyberLink PowerDirector
Chapter 5:

Producing Your Video

When you are done creating your movie, it is time to produce it. Producing a movie simply means compiling (or rendering) the separate elements it contains into a playable video file. As your video production may be destined for many different uses, CyberLink PowerDirector has several options suited for all your production requirements.

Viewing SVRT Information

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that recognizes which portions of a movie clip were modified (and therefore require rendering during production), and which portions of a movie clip were not changed (and thus can be skipped over during the rendering process). By viewing SVRT information, you can simulate the production process.

To view how CyberLink PowerDirector uses SVRT in your current project, click View > SVRT Information. For more information, see "SVRT: When Can I Use it?" on page 105.

The colors that appear in the SVRT track indicate how CyberLink PowerDirector uses SVRT for the related clip (or clip portion).

- **Green**: no rendering is required during production.
- **Blue**: only video rendering is required.
- **Yellow**: only audio rendering is required.
- **Red**: both audio and video rendering are required.

Produce Window

When you click the **Produce** button, CyberLink PowerDirector enters the produce window. Here you can compile your movie into a file that is ready for a variety of uses, including e-mailing to friends, uploading to YouTube or for burning to disc at a later date.

**Note**: if you want to burn your current movie production to a disc right away, go directly to the **Create Disc** module. In the **Create Disc** module you can create a disc menu, produce your movie, and then burn it to disc, all in a few simple steps.
When you click the Produce button, the produce window displays as follows:

- A - Output to File
- B - Output to Camcorder
- C - Upload to YouTube
- D - Production Formats
- E - Upload to Facebook
- F - Production Preview
- G - Production Details
- H - Video Profile Settings
- I - Production Preferences

The production window is an easy to use interface that makes video production effortless.

**Note:** before producing your movie, make sure that all of your video clips have the same interlacing format. This is an extremely important step to take before production, as it can drastically affect final video quality. If you produce your movie and find the video quality unsatisfactory, verify if the interlacing format of all of your video clips is the same. If your clips have different interlacing formats, set them all to the same format, then produce your movie again. For more information, see "Setting Video Clip Interlacing Format" on page 52.
In the produce window, select the production option that matches the task you want to perform. You can select one of the following production options:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Click on the File tab if you want to output your video to file that you can watch on a computer, portable device, or burn to a disc at a later date. There are file formats available for all of your production requirements. See &quot;Outputting to a File&quot; on page 81 for more information.</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Click on the Camcorder tab if you want to produce your video and then output it to a DV, HDV or HDD camcorder. See &quot;Outputting to a Camcorder&quot; on page 83 for more information.</td>
</tr>
<tr>
<td>YouTube</td>
<td>Click on the YouTube tab if you want to upload your video to YouTube. When you select this option, CyberLink PowerDirector produces your video and then uploads it directly to your YouTube account. See &quot;Uploading Video to YouTube&quot; on page 84 for more information.</td>
</tr>
<tr>
<td>Facebook</td>
<td>Click on the Facebook tab if you want to upload your video to Facebook. When you select this option, CyberLink PowerDirector produces your file and then uploads it directly to your Facebook page. See &quot;Uploading Video to Facebook&quot; on page 85 for more information.</td>
</tr>
</tbody>
</table>

**Note:** you can also produce multiple created movie projects at one time from within the Edit window using the Batch Produce feature. To perform a batch production, select 🌐 > File > Batch Produce.

**Outputting to a File**

You can output your video to a file, which you can watch on a computer, burn to disc, or output to a portable device. To output your video to a file, select the File tab and then select the desired file format.

You can output your video to one of the following formats:

- AVI
CyberLink PowerDirector

- MPEG-1
- MPEG-2
- MPEG-4 portable*- formats for iPod, PSP and mobile phones available
- H.264 AVC
- Windows Media Video
- RealMedia
- QuickTime*

**Note:** * optional features in CyberLink PowerDirector. Check the readme file for detailed versioning information.

**Customizing Video Profiles**

After you select a file format for your outputted video file, depending on the format you selected, there may be video quality settings you can customize in the video profiles section.

These video quality settings are called profiles, and can consist of your video’s resolution, bitrate compression, audio compression type, and more.

Before you output your production to a video file, you may want to create a new quality profile, edit an existing one, or select a different existing profile and other options from one of the available drop-downs in the production options section.

**Configuring Production Preferences**

Before you begin producing your file, you can select from the following production preferences:

**Note:** the preferences that are available depend on the file format you selected and the version of CyberLink PowerDirector that is installed on your computer.

- **Fast video rendering technology:** SVRT and Hardware video encoder are options that can reduce production time. The Hardware video encoder option is only enabled if you are using a NVIDIA graphics card that supports CUDA technology or an ATI graphics card that supports Stream technology, and it is enabled in the **GPU acceleration** section on the Editing Preferences tab.
- **Dolby Digital 5.1:** select this preference if you want to include Dolby Digital 5.1 audio in your produced video file.
Chapter 5: Producing Your Video

- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
- **x.v.Color**: x.v.Color is a new color system that can display a wider color range than usual. CyberLink PowerDirector can generate an x.v.Color-compliant stream, which is backward compatible with RGB displays, while offering the opportunity to achieve better visual quality if your playback environment is x.v.Color ready).
- **Shut down after production**: select this option for if you want to shut down your computer automatically after CyberLink PowerDirector finishes producing your video.

**Outputting to a Camcorder**

Select the **Camcorder** option if you want to produce your movie and then write it back to a DV or an HDV tape.

---

**Note**: you must manually locate the position on your HDV camcorder tape where you want to write back your content to before proceeding.

You can also output your production to a file that you can then copy back to an HDD (hard disk drive) camcorder.

**Customizing Video Profiles**

After you select whether to output your file to a DV, HDV* or HDD camcorder, depending on your selection, there may be video quality settings you can customize in the video profiles section.

---

**Note**: * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

These video quality settings are called profiles, and can consist of your video's resolution, bitrate compression, audio compression type, and more.
Before you output your production, you may want to create a new quality profile, edit an existing one, or select a different existing profile and other options from one of the available drop-downs in the production options section.
Configuring Production Preferences
Before you begin producing, you can select from the following production preferences:

**Note:** the preferences that are available depend on the file format you selected and the version of CyberLink PowerDirector that is installed on your computer.

- **Fast video rendering technology: SVRT** and **Hardware video encoder** are options that can reduce production time (available for creating an HDD camcorder file only). The Hardware video encoder option is only enabled if you are using a NVIDIA graphics card that supports CUDA technology or an ATI graphics card that supports Stream technology, and it is enabled in the **GPU acceleration** section on the Editing Preferences tab.
- **Dolby Digital 5.1**: select this preference if you want to include Dolby Digital 5.1 audio in your produced video file (available for creating an HDD camcorder file only).
- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
- **Delete the file after the write back is complete**: select this option to have CyberLink PowerDirector delete the produced video file after it has written it back to your DV or HDV camcorder.
- **x.v.Color**: x.v.Color is a new color system that can display a wider color range than usual (available for creating an HDD camcorder file only). CyberLink PowerDirector can generate an x.v.Color-compliant stream, which is backward compatible with RGB displays, while offering the opportunity to achieve better visual quality if your playback environment is x.v.Color ready.
- **Shut down after production**: select this option for if you want to shut down your computer automatically after CyberLink PowerDirector finishes producing your video.

Uploading Video to YouTube

In just a few steps, you can upload your video production from within CyberLink PowerDirector directly to YouTube®.

To upload your video to YouTube®, select the **YouTube** tab and then fill in all of the YouTube and video information in the fields provided.
Chapter 5: Producing Your Video

Note: log in to DirectorZone and then select **Share timeline info on DirectorZone** if you want to show others how you created your video production. When selected, an animated version of your project’s timeline displays, along with your uploaded video, on DirectorZone.

**Selecting Video Quality**
Before uploading your video to YouTube, ensure that you select the desired quality of your video from the drop-down list. The quality you select will result in the corresponding quality option being available after the video is fully processed on YouTube.

Note: the quality option available on YouTube is also dependent on the original captured video quality and the bandwidth of the user who is watching the video.

**Configuring Production Preferences**
Before you begin producing, you can select from the following production preferences:

- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
- **Shut down after production**: select this option for if you want to shut down your computer automatically after CyberLink PowerDirector finishes uploading your video.

**Uploading Video to Facebook**
In just a few steps, you can upload your production from within CyberLink PowerDirector directly to Facebook®.

To upload your video to Facebook®, select the **Facebook** tab, follow the instructions on the user interface to authorize the upload, and then fill in the video information in the fields provided.
Selecting Video Quality
Before uploading your video to Facebook, ensure that you select the desired quality of your video from the drop-down list.

Configuring Production Preferences
Before you begin producing, you can select from the following production preferences:

- **Enable preview during production**: select this option to preview your movie during production. Selecting this option will increase the time required to produce your file.
- **Shut down after production**: select this option for if you want to shut down your computer automatically after CyberLink PowerDirector finishes uploading your video.
Chapter 6: Creating Discs

After you finish creating your video production, click on **Create Disc** to open the Create Disc module. Within the Create Disc module you can burn your movie onto a CD, DVD or Blu-ray Disc (Ultra version only), complete with stylish menus, in just a few simple steps. You can also import other videos and CyberLink PowerDirector projects, creating multi-layered a professional looking disc.

A - Disc Content Tab, B - Menu Preferences Tab, C - Disc Preferences Tab, D - Disc Menu Properties, E - Burn to Disc, F - Preview Disc Menu, G - Toggle Display, H - Disc Content
Importing Disc Content

The Content tab contains all of the videos and projects (called titles on your disc) that are currently in your disc menu and will be burned to a disc. It not only includes any current video production, but also any imported videos you produced earlier or CyberLink PowerDirector projects you previously worked on. On the Content tab you can:

- click on + to import any existing videos that you want on your created disc.
- click on + to import any existing CyberLink PowerDirector projects that you want on your created disc.
- click on the Menu Structure button to view a structure tree of your disc menu. This structure tree includes all the titles on your disc and displays any chapters contained within.

Once you import all of the videos and CyberLink PowerDirector projects that you want into your disc menu, you can then perform the following functions:

- click on 🎬 to play the selected title.
- click on 🗑️ to remove the selected title from the disc menu.
- click on 💰 to edit the selected title in the Edit module.
- click on 📚 to view/set/edit the selected title’s chapters.

Disc Menu Preferences

Click on the Menu Preferences tab to edit the existing disc menu or to select a different menu template.

All the menu templates within CyberLink PowerDirector are multi-layered, consisting of a main menu home (root) page with text links to play your movie, select chapters or turn on subtitles if included on your disc.

Note: the Subtitles page within disc menus is only available if you selected Create subtitles for disc when creating subtitles in the Subtitle Room. See “Subtitles” on page 76 for more information.
Selecting Pre-designed Templates

CyberLink PowerDirector provides you with several stylish pre-designed menu templates that you can choose from. These menus are already customized for you and may include such features as motion and menu music.

The menu page templates are divided into two categories:

- menu templates with clickable chapter thumbnail buttons.
- menu templates with clickable chapter text.

Select a menu template to preview it and use it on your disc. Select Apply to apply the highlighted menu page style to the specified menu page. Select Apply to All Pages if you want to use the same style on every page.

Note: if required, you can download and import additional disc menu templates from DirectorZone. See "Downloading Templates from DirectorZone" on page 23 for more information.

Customizing Disc Menu Properties

CyberLink PowerDirector gives you full creative control over the look and creation of your disc menu. The disc menu properties area provides a preview of the current disc menu that will be burned to disc. Click the Preview button to view a preview of your burned disc at any time.

To edit text that appears on the menu page, including clickable chapter text, double-click on it, and then enter the new text. Modify menu text style, size, alignment and position using the text properties options located at the top of the disc menu properties area.

Setting Disc Menu Background Music

Some of the pre-designed disc menu templates contain menu music. You can edit the existing music or click to add new music as your menu’s background music. You can also:

- click to remove the current background music from the menu.
- click to add background music with Magic Music. See "Magic Music" on page 57 for more information.
Adding a First Play Video
Use this option to add a video (or an existing CyberLink PowerDirector project) as a first play video to your created disc. The first play video plays automatically when the disc is inserted into a disc player, before the disc menu loads. No navigation buttons are available during the first play, and viewers cannot fast forward past this segment. In a professional production, this is usually a copyright notice or warning. However, you may prefer to use a personal introduction or other video clip instead.

To set a clip as first play, do this:
- click and select the video file that you want.
- click to remove the video file set as first play.
- click to preview the first play video.

Setting Playback Mode
Click the button to set how the disc plays back in a disc player. Select from one of the available playback modes in the list.

Note: select the Auto menu time out option in the Playback Mode Settings window if you want your disc content to begin playing automatically after displaying the disc menu for the specified duration.

Specify Buttons Per Page
When creating a disc with multiple titles or chapters, you can select the number of thumbnails you want to display on the menu or chapter page. Use the Buttons per page drop-down to select the number you want to display.

Note: once you select the number of thumbnails you want to display, you can move the thumbnails (and any menu text) anywhere you want on your menu.

Select Add thumbnail index to add numbering of your thumbnails to your menu page.
Using the Menu Designer

The Menu Designer* lets you customize a selected disc menu style. Click on the Menu Designer button to open it and begin customizing the selected menu.

A - Upload to DirectorZone, B - Change Text Properties Tab, C - Text Properties, D - Set Object Properties Tab, E - Save Custom Template, F - Set Button Properties Tab, G - Add Objects, H - TV Safe Zone/Grid Lines, J - Menu Page View (Go to)

Note: * optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

Within the Menu Designer you can edit all three possible disc menu pages. To modify a specific page, select either Root Menu, Titles/Chapters Menu or Subtitles Menu from the Go to drop-down menu.
Note: the subtitles menu page is only available if you selected **Create subtitles for disc** when you added subtitles in the Subtitle Room. See "Subtitles" on page 76 for more information.

**Applying Preset Character Types**
On the text properties tab you can apply a predefined character preset for the menu text. After you have applied the predefined character preset you can go to font face, shadow, or border tabs to make further changes to the text properties if required.

**Customizing Menu Text Fonts**
On the text properties tab you can customize the font used in menu text, including the size, color, font type used, weight, alignment, transparency and blur effect.

**Adding Shadows to Menu Text**
On the text properties tab you can add a shadow around the text in the menu. Available options allow you to change the shadow’s color and size and add a transparency or blur effect.

**Adding Borders Menu Text**
On the text properties tab you can add a border around the text in the menu text. Available options allow you to change the border’s color and size and add a transparency or blur effect.

**Setting Object Properties**
On the set object properties tab you can customize all of your menu properties. The tab lists all of the current objects on your menu, including menu buttons, navigation buttons and text.
When you select an item in the objects list, the object is highlighted in the preview window. Once highlighted, the objects are easily edited, resized, reshaped or moved around the disc menu to a desired location.

Note: when creating a menu with clickable chapter text, on this tab you can easily select, edit and position the clickable text objects to the desired position.
Chapter 6: Creating Discs

Select **Display the selected object only** to only display the selected object while setting the properties. Use the add objects buttons to:

- **-** import a custom image into your disc menu.
- **-** add a new blank text field into your disc menu.
- **-** add a new button into your disc menu.

**Note:** click on **to use the TV safe zone and grid lines to help with the precise movement of the objects on your menu pages.**

**Setting Button Properties**

On the set button properties tab you can customize your menu and navigation buttons for your disc menu in the Menu Designer, by selecting a button frame, setting button position or setting a button highlight style.

**Note:** if you selected a menu template that uses clickable chapter text, you can only customize the menu’s navigation buttons.

On the set button properties tab, set the effects as follows:

- **-** click on **to select a chapter thumbnail button frame style. Select **Import Custom** to import your own button frame style.**
- **-** click on **to set chapter thumbnail button layout.**
- **-** click on **to select a navigation button style. Select **Import Custom** to import your own navigation button style.**
- **-** click on **to select a button highlight style. Select **Import Custom** to import your own button highlight style.**

**Replace Background Image or Video**

To replace the background image or video in your disc menu, click on the **Replace background image or video** button **.**
Select a Video Effect
To select a video effect that will be dynamically applied to your disc menu, click on the **Select a video effect** button.

Saving and Sharing Disc Menu Templates
Once you have finished modifying your disc menu template you can save it to the Menu Properties tab for future use or upload it to DirectorZone to share it with others.
- click on **Share** to upload your custom template to DirectorZone.
- click on **Save** to save the modified template to the Template section of the Create Disc window

Disc Preferences
Before you proceed to burn your creation to a disc, it is recommended that you configure your disc preferences, including disc and video file format, audio format, etc. Click on the **Disc Preferences** tab to configure your disc’s preferences.

The following preferences are available on the **Disc Preferences** tab:

**Disc Format**
- select the disc format you want to use to burn your video to a disc. Depending on the disc format that you select, there may be a drop down option to select the capacity of the disc.

**Note:** you can also burn your video project to a removable in the AVCHD format. To do this, select the **AVCHD** button and then **Removable Disk** from the drop down.

Video and Audio Settings
- **Video recording format:** if available for your selected disc format, select the recording format of the video on your disc and its aspect ratio.
- **Video encoding format and quality:** if available for your selected disc format, select an encoding format and video quality for your disc. The Smart Fit option automatically adjusts the bit rate to the best quality video file that fits exactly to the capacity of the disc you are using.
- **Audio encoding format and channels:** select an audio format for your disc, and the number of channels it is capable of outputting to.
Chapter 6: Creating Discs

**Note:** the video quality and audio type options that are available depend on the disc format that you have selected.

- **Enable CyberLink TrueTheater Surround to enhance stereo sound:** select this option to enable CyberLink TrueTheater Surround to enhance the menu background music. Choose between Living Room, Theater, and Stadium.

## Burn to Disc

After you have acquired your media, assembled your story, edited your clips, added audio and visual effects, and customized the layout and look of your disc, then it’s time to finalize your production.

CyberLink PowerDirector offers several methods to finalize your production, which are useful under different circumstances. You can burn your production to disc as the last step in your movie production process, or create a DVD folder to organize your media files on your hard drive. Depending on your burning drive and disc type, one or more of these options may be available simultaneously.

CyberLink PowerDirector supports the following disc formats for burning:
- **DVD:** DVD-R, DVD-RW, DVD+R, DVD+RW
- **VCD/SVCD:** CD-R, CD-RW
- **Blu-ray Disc:** BD-RE, BD-R

**Note:** see "Disc Preferences" on page 94 for information on selecting your disc type for burning. * Optional feature in CyberLink PowerDirector. Check the readme file for detailed versioning information.

## Burn Your Movie to Disc

Burning your movie to disc is the final stage of the create disc process. Once your disc is burned, you are able to play it on a disc player. Click on the **Burn** button to begin the burning process.

**Note:** the burning process may take at least a few minutes, depending on the length and quality of your video and your computer’s processing power. Be prepared for a short wait while CyberLink PowerDirector renders your movie.
Setting Burning Configuration
Before you burn to a disc for the first time, it is advised that you click on \( \text{[Set Configuration]} \) to set your burning configuration. After you set this configuration, CyberLink PowerDirector uses the same configuration each time you burn until you change the settings.

Creating Folders
Selecting Create a folder in the Burn window creates a folder on your computer that contains all the files necessary for burning. This folder can then be burned to disc at a later date.

Note: creating a folder overwrites all of the existing data in a directory.

Erasing Discs
If you are using a rewritable disc, you can erase content that has data previously recorded on it. This allows you to reuse the same discs over and over without the need to continually buy new discs. Click on the \( \text{[Erase Disc]} \) button to begin erasing a disc.

When erasing a disc, select:
- the Quick option to erase the disc index contained on the disc.
- the Full option to erase all of the content the disc contains.
Chapter 7: Appendix

This chapter contains reference information to help answer questions you may have about the digital movie production process or about using CyberLink PowerDirector.

Hotkeys

CyberLink PowerDirector allows you to employ a number of hotkeys to make working with video quicker and easier. These hotkeys are organized by function and described below.

System Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected item(s)</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Show Hotkey list help</td>
</tr>
<tr>
<td>Alt + space bar</td>
<td>Open the Minimize menu in the top-left corner</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit CyberLink PowerDirector</td>
</tr>
</tbody>
</table>
## Project Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>Create new project</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Alt + Enter</td>
<td>Display project properties</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save project as</td>
</tr>
<tr>
<td>Ctrl + Shift + W</td>
<td>New Workspace</td>
</tr>
</tbody>
</table>

## Workspace Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Switch between Timeline/Storyboard</td>
</tr>
<tr>
<td>Home</td>
<td>Go to the beginning of clip/project</td>
</tr>
<tr>
<td>End</td>
<td>Go to the end of clip/project</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous frame</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next frame</td>
</tr>
<tr>
<td>Down arrow</td>
<td>Next second</td>
</tr>
<tr>
<td>Up arrow</td>
<td>Previous second</td>
</tr>
<tr>
<td>Alt + 1</td>
<td>Opens the Magic Fix function</td>
</tr>
<tr>
<td>Alt + 2</td>
<td>Opens the Magic Motion function</td>
</tr>
<tr>
<td>Alt + 3</td>
<td>Opens the Magic Cut function</td>
</tr>
</tbody>
</table>
### Chapter 7: Appendix

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + 4</td>
<td>Opens the Magic Style function</td>
</tr>
<tr>
<td>Alt + 5</td>
<td>Opens the Magic Music function</td>
</tr>
<tr>
<td>Alt + 6</td>
<td>Opens the Magic Movie Wizard</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Go to next clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Go to previous clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>+</td>
<td>Zoom ruler In</td>
</tr>
<tr>
<td>-</td>
<td>Zoom ruler out</td>
</tr>
<tr>
<td>Alt + L</td>
<td>Lock all tracks except Master Video track</td>
</tr>
<tr>
<td>Alt + U</td>
<td>Unlock all tracks</td>
</tr>
<tr>
<td>Alt + C</td>
<td>Open Preferences</td>
</tr>
</tbody>
</table>
## Smart Guide Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + T</td>
<td>Display Trim Audio options</td>
</tr>
<tr>
<td>Ctrl + Alt + M</td>
<td>Display Multi Trim options</td>
</tr>
<tr>
<td>F2</td>
<td>Open PiP Designer, Particle Designer, Title Designer, Effect Settings</td>
</tr>
</tbody>
</table>

## Main Panel Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F9</td>
<td>Switch to Capture mode</td>
</tr>
<tr>
<td>Alt + F10</td>
<td>Switch to Edit mode</td>
</tr>
<tr>
<td>Alt + F11</td>
<td>Switch to Produce mode</td>
</tr>
<tr>
<td>Alt + F12</td>
<td>Switch to Create Disc mode</td>
</tr>
</tbody>
</table>

## Library Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Rename media file</td>
</tr>
<tr>
<td>F3</td>
<td>Open Media Room</td>
</tr>
<tr>
<td>F4</td>
<td>Open Effect Room</td>
</tr>
<tr>
<td>F5</td>
<td>Open PiP Objects Room</td>
</tr>
<tr>
<td>F6</td>
<td>Open Particle Room</td>
</tr>
<tr>
<td>F7</td>
<td>Open Title Room</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>F8</td>
<td>Open Transition Room</td>
</tr>
<tr>
<td>F9</td>
<td>Open Audio Mixing Room</td>
</tr>
<tr>
<td>F10</td>
<td>Open Voice-Over Recording Room</td>
</tr>
<tr>
<td>F11</td>
<td>Open Chapter-Setting Room</td>
</tr>
<tr>
<td>F12</td>
<td>Open Subtitle Room</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Switch between filters</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Detect scenes</td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Import media file(s)</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Import a media folder</td>
</tr>
</tbody>
</table>
# Capture Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Record</td>
</tr>
<tr>
<td>Space bar</td>
<td>DV play/pause preview</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>DV stop preview</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>DV rewind</td>
</tr>
<tr>
<td>Ctrl + . (period)</td>
<td>DV fast forward</td>
</tr>
<tr>
<td>Alt + Y</td>
<td>Add text captions on captured video</td>
</tr>
</tbody>
</table>

# Voice-Over Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + H</td>
<td>Fade-in</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Fade-out</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
</tbody>
</table>
# Preview Window Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space bar</td>
<td>Play/pause</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous unit</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next unit</td>
</tr>
<tr>
<td>Page Up</td>
<td>Switch to Clip mode</td>
</tr>
<tr>
<td>Page Down</td>
<td>Switch to Movie mode</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Fast forward</td>
</tr>
<tr>
<td>[</td>
<td>Mark in</td>
</tr>
<tr>
<td>]</td>
<td>Mark out</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Takes a snapshot of content in the preview window</td>
</tr>
<tr>
<td>Ctrl ++ (plus)</td>
<td>Increase volume</td>
</tr>
<tr>
<td>Ctrl + - (minus)</td>
<td>Decrease volume</td>
</tr>
<tr>
<td>Ctrl + Backspace</td>
<td>Mute/Mute off</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Adjust system volume</td>
</tr>
</tbody>
</table>

# Title Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Set text in bold</td>
</tr>
<tr>
<td>Hotkey</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Set text in italics</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left-align text</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right-align text</td>
</tr>
</tbody>
</table>
SVRT: When Can I Use It?

SVRT can be applied to video clips in the MPEG-1, MPEG-2, H.264 (Ultra version only) and DV-AVI (Type I) formats. In the following conditions, clips (or portions of clips) do not require rendering during production, and SVRT can therefore be applied:

- The frame rate, frame size, and file format are the same as those of the destination production profile.
- The bitrate is similar to that of the destination production profile.
- The TV format is the same as that of the destination production profile. For more information, see "Setting Video Clip Interlacing Format" on page 52.

If all of the above conditions are met, SVRT can be used. Any clips that do not meet the above criteria are fully rendered without SVRT.

In the following conditions, clips (or portions of clips) must be rendered during production, and SVRT can therefore not be applied:

- Adding a title or transition effect
- Modifying the color of a video clip
- Audio profile does not match destination production profile
- Modifying the volume of an audio clip
- Merging two video clips (clips within 2 seconds before or after the merged clips will be rendered)
- Splitting a video clip (clips within 2 seconds before or after the split will be rendered)
- Trimming a video clip (clips within 2 seconds before or after the trimmed clip will be rendered)
- If the total duration of the production is less than one minute and any portion of the video requires rendering, the entire production will be rendered for efficiency reasons.

Licenses and Copyrights

This document contains the CyberLink PowerDirector licensing and copyright information for Dolby Laboratories only. For the remaining list of applicable licensing and copyright information for CyberLink PowerDirector, please consult the Readme file.
Dolby Laboratories

Manufactured under license from Dolby Laboratories. “Dolby,” and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-1997 Dolby Laboratories. All rights reserved.
Chapter 8:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

Before Contacting Technical Support

Please take advantage of one of CyberLink's free technical support options:

- consult the user's guide or the online help installed with your program.
- refer to the Knowledge Base in the Support section of the CyberLink web site.

http://www.cyberlink.com/prog/support/cs/index.do

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

- registered activation key (Your activation key can be found on the CD cover, the Box cover, or in the email received after you purchased CyberLink products on the Cyberlink store).
- the product name, version and build number, which generally can be found by clicking on the product name image on the user interface.
- the version of Windows installed on your system.
- hardware devices on your system (capture card, sound card, VGA card) and their specifications.
- the wording of any warning messages that were displayed (You may want to write this down or take a screen capture).
- a detailed description of the problem and under what circumstances it occurred.
Web Support
Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

Note: you must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs and a user community forum, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/prog/support/cs/index.do">http://www.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="http://tw.cyberlink.com/prog/support/cs/index.do">http://tw.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/prog/support/cs/index.do">http://it.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/prog/support/cs/index.do">http://de.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/prog/support/cs/index.do">http://es.cyberlink.com/prog/support/cs/index.do</a></td>
</tr>
</tbody>
</table>
Index

A

Add
  chapters 11
Apply re-focus 51
Aspect ratio
  adjust 53
  setting 37
Audio
  adding clips to the workspace 43
  change levels 71
  denoise 51
  in-track mixing 71
  Magic Music 57
  mixer 72
  mixing room 11
  record voice-over 74
  restore volume 73
  split 30
  split from video 71
  trim 49
Audio mixer 72
AVCHD
  import 27

B

Batch production 81
Burning
  configuration 96
  create folder 96

C

Camcorders
  AVCHD 27
Capture
  format 28
  from CD 27
  from Digital TV 26
  from DV camcorder 25
  from DVD 27
  from HDV camcorder 26
  from microphone 27
  from TV 26
  from webcam 27
  options 28
  overview 24
  preferences 34
  quality 28
  single scene 25
Captured content 28
CD
  capture from 27
Cell phones 82
Chapters
  overview 11
  set thumbnail 75
  setting 75

Overview 95
Buttons
  frame style 93
  highlight style 93
  layout 93
  navigation 93
  per page 90
  set effects 93
track 18
Chroma key effect 60
Color
  adjustment 51
Color boards, adding 43
Confirmation preferences 34
Content
  import 88
Create a folder 96
Create disc
  add music 89
  customize 89
  menu designer 91
  modify text 89
  new features 3
  preferences 94
  preview 89
Create slideshow 38
Cropping
  video 51
CUDA 33

Disc formats supported 95
Disc menus
  add music 89
  button effects 93
  button frame 93
  button highlight 93
  button layout 93
  buttons per page 90
  customize 89
  first play video 90
  import content 88
  menu designer 91
  modify text 89
  navigation button 93
  preferences 94
  preview 89
  save 94
  share 94
  structure 88
  template style 89
  text shadow 92
  video effect 94

Downloading
  audio 23
  media 22
  photos 22
  PiP templates 23
  title templates 23
Dual preview 16
Duration
  default 33
  of capture 29
DV
  parameters 35
DV Backup 25
DV camcorder
  capture from 25
DVD
capture from 27

Freesound 23
Freeze frame 52
Full erase 96

Index

E
Edit
  image 51
  photo 51
  video 48
Editing
  new features 2
  preferences 33
Effect track
  adding effects 44
  description 18
Effects, overview 10
Enhance 51
Erasing discs 96
EXIF 52
Extract audio 30

G
General preferences 32
GPU acceleration 33
Grid lines 16, 56, 60, 65, 68, 93

H
HD
  TrueTheater 51
HDV camcorder
    capture from 26
Hotkeys 97

I
Images
  edit 51
Import
  audio 23
  background image 93
  buttons 93
  file formats 21
  media 21
  photos 22
  subtitles 77
  videos 88
  Interlacing format, setting 52
In-track audio mixing 71
Invert 49
iPod 82

Language, change 32
Latest features 2
Library
  detecting scenes in clips 29
  manage 10
  menu 13
  overview 10
Lighting adjustment 51

Magic Cut 56
Magic Fix 54
Magic Motion 54
Magic Motion Designer
  zoom 56
Magic Movie Wizard 54
Magic Movie wizard 38
Magic Music 57
Magic Style 56
Manage library 10
Masks 63
Maximum undo levels, setting 32
Media room 10
Media viewer 17
Menu designer
  button effects 93
  button frame 93
button highlight 93
button layout 93
modify text 89
navigation buttons 93
overview 91
text shadow 92
video effect 94
Microphone
  capturing from 27
Mixing
  audio 72
  in-track 71
Mixing audio 72
Mobile phones 82
Modifying effects
  title 66
  video 57
Motion
  adding to image clip 54
  of particle effects, modifying 66
  of PiP effects, modifying 60
Motion designer 55
Multi trim 48
Music
  add tracks 43
  disc menus 89
Music track
  adding clips 43
  description 18
Mute
  audio tracks 50
Narration, recording 74
Navigation buttons 93
Non real-time capture 29
preview 17

O
OEM versions 4

P
Particle designer 64
Particle effects
  adding to timeline 45
  modifying 64
  modifying motion 66
  modifying position 65
  modifying size 65
  overview 11
  save 66
  share 66
PhotoNow! 51
Photos
  adding to workspace 42
  edit 51
  Magic Fix 54
PiP
  zoom 15
PiP designer 58
PiP effect
  modifying 58
  speed 61
PiP effects
  customize motion 61
  customize rotation 62
  modifying motion 60
  modifying position 59
  modifying size 59
  predefined motion 61
  save 62
  shadows 60
  share 62
  transparency 62
PiP Objects
  modifying 58
PiP objects
  add PiP tracks 19, 42
  adding to timeline 45
  download 23
  overview 10
PiP track
  add 19
  adding media 42
  adding objects 45
  adding particle effects 45
  description 18
Power Tools 2
PowerDirector
  modes 5
  preferences 30
  projects 37
  upgrade 5
  versions 4
Preferences 30
  disc menu 94
Preview
  disc menu 89
  dual 16
  production 15
  quality 15
  window 15
Produce
create an HDD camcorder file 83
multiple projects 81
new features 3
overview 79
preferences 35
upload to Facebook 85
upload to YouTube 84
write back to DV tape 83
write back to HDV tape 83
your movie 79
Profiles 28, 82, 83
PSP 82

Q

Quality 15
capture 28
produced video 82, 83
Quick erase 96

R

Range selection 19
Real-time preview 16
Record voice-over 74
Red-eye 51
Resize 13
Resizing the ruler 14
Restoring volume levels 73
Reverse
video 51
RichVideo 52
Ripping CD tracks 27
Rotate

S

Save
character preset 70
disc menu template 94
particle effect template 66
PiP motion path 62
PiP template 62
title template 70
Scene detection 29
Secondary display 16
Set chapter thumbnail 75
Set chapters 75
Settings
default durations 33
maximum undo levels 32
Shadows
in menu text 92
in PiP effects 60
in title effects 69
Share
disc menu template 94
editing details 85
particle effect template 66
PiP template 62
title template 70
video on Facebook 85
video on YouTube 84
Slideshow
customize 40
designer 38
Slideshow Designer 40
Slow motion 51
Index

Snap to reference 16
Snapshot 15
  default destination 31
  default filename 31
Speed
  PiP effect 61
  title effects 69
Speed, video 51
Split
  audio 30
Splitting clips 47
Stabilizer 51
Storyboard 20
Subtitles
  add 76
  edit 76
  import 77
  overview 12
  sync 77
  track 18
Supported file formats 21
SVRT
  overview 105
  viewing in project 79
System requirements 6

T

Text remark 29, 52
Time code 29, 52
Time info 52
Timeline
  adding media 37
  adding particle effects 45
  adding PiP objects 45
  adding title effects 46
  adding transition effects 46
  adding video effects 44
  fit 14
  hide tracks 20
  lock tracks 19
  overview 17
  unlock tracks 19
  view 17
Title effects
  adding to timeline 46
  animations 69, 70
  download 23
  modifying font 68
  modifying position 68
  overview 11
  save 70
  shadows 69
  share 70
  speed 69
Title track
  adding titles 46
  description 18
Track manager 19
Tracks
  descriptions 18
  hide 20
  lock 19
  manage 19
  unlock 19
Transition effects
  adding random 46
  adding to timeline 46
Transitions, overview 11
Transparency of PiP effects 62
Trim
  audio 49
  range 19
video 48, 49
TrueTheater
  audio 95
  video 51
TV
  capture from 26
TV safe zone 16, 56, 60, 65, 68, 93

U
Unlock track 19
Update SVRT Info 79
Upgrade 5
Upload
  disc menu template 94
  particle effect template 66
  PiP template 62
  title templates 70
  video to Facebook 85
  video to YouTube 84
Upscaling 51

V
Video
  adding to workspace 42
  crop 51
denoise 51
edit 48
enhance 51
enhancement 51
Magic Fix 54
Magic Style 56
overlay 35
preview 15
profiles 82, 83
quality, YouTube 85
reverse 51
rotation 52
speed 51
split 47
split audio 71
trim 48, 49
upsampling 51
Video clip
  detecting scenes in 29
  extract audio 30
Video effects
  add to entire clip 44
  adding to timeline 44
  disc menu 94
  modifying 57
Video track
  adding color boards 43
  adding media 42
  adding transitions 46
description 18
Voice track
  adding audio 43
description 18
Voice-over recording 74
Voice-over recording room 11
Volume
  adding keys 72
  changing in-track 71

W
Webcam
  capturing from 27
White balance 51
Window
  resize 13
Workspace
  adding clips to 42
  adding effects to 44
  adding titles to 44
  adding transitions to 44
  extend 16
  resize 13
  storyboard view 20
  timeline view 17
Write back to
  DV tape 83
  HDV tape 83

Y

YouTube 81
  upload to 84
  video quality 85

Z

Zoom 15, 56